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Foreword

Daniel Ganu, DrPH
Dean, School of Postgraduate Studies,
Associate Professor of Public Health

Welcome to the School of Postgraduate Studies. On behalf of the faculty at the School
of Postgraduate Studies (SPS), | warmly welcome you to Adventist University of Africa
(AUA) and the School. As a graduate student at AUA, you will face many exciting and
rewarding experiences. It is a privilege to study at the postgraduate level and we trust
that you will make the most of your opportunities.

There are several documents that are important to your success at AUA and SPS. One is
the Academic Bulletin, which you can find at the AUA Website. The other is the SPS
Research Handbook 2020, which you are reading now and is also located at the AUA
Website. The SPS Research Handbook is an invaluable guide as you plan, execute, write
and submit your research, which must be professionally done before you can graduate.
If you follow the SPS Research Handbook, diligently, your path to successful completion
of your research will be considerably easier.

We pray that God will richly bless you in your postgraduate studies and that your skills
and talents will be used for His glory and in the service of humankind.

Daniel Ganu, DrPH
Contact Information: spsdean@aua.ac.ke
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Attribution — Non-Commercial — Share Alike

You are free:

1.
2.

To Share — to copy, distribute and transmit the work
To Remix — to adapt the work

Under the following conditions:

1.

2.
3.

Attribution — You must attribute the work in the manner specified by the
author or licensor (but not in any way that suggests that they endorse you or
your use of the work).

Noncommercial — You may not use this work for commercial purposes.

Share Alike—If you alter, transform, or build upon this work, you may
distribute the resulting work only under the same or similar license to this
one.

With the understanding that:

4,

Waiver — Any of the above conditions can be waived if you get permission
from the copyright holder.

Other Rights — In no way are any of the following rights affected by the
license:

Your fair dealing or fair use rights, or other applicable copyright exceptions
and limitations;

The author’s moral rights;

Rights other persons may have either in the work itself or in how the work is
used, such as publicity or privacy rights.

Notice — For any reuse or distribution, you must make clear to others the
license terms of this work. The best way to do this is with a link to the web
page where this information was taken from:
http://creativecommons.org/licenses/by-nc-nd/3.0/

Sections of this work were adapted from the AUA Standards for Written Work, 2014.
Appreciation is expressed to Dr. Shawna Vyhmeister and the other contributors for the
work that produced the AUA Standards for Written Work 2014 which served students
in the School of Postgraduate Studies, the Theological Seminary, and the University

well.
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OVERVIEW OF RESEARCH AT AUA

The faculty of the School of Postgraduate Studies (SPS) is pleased to make available
to our students the resources of the SPS Research Handbook 2020. As a student in SPS,
you are a valuable part of AUA and we want your total research experience to be
successful. That is why the SPS Research Handbook was developed—to give you
specific guidance for planning, writing and submitting your project/thesis/dissertation.

The SPS Research Handbook is revised from the former AUA Standards for Written
Work, but is more complete because of the addition of the SPS Research Protocol in a
format that gives you all the information you need to navigate the process in one place.
You can find the entire SPS Research Protocol at the end of the SPS Research Handbook.
However, you will also find that the applicable sections of the Protocol are placed
throughout the SPS Research Handbook so that you can follow the Protocol in context.
You will notice, too, that copies of all forms you need to process your
project/thesis/dissertation are included in the SPS Research Handbook, along with
sample pages that you can adapt to your research paper.

The SPS Research Handbook has a companion—The Quick Guide to Successful
Project/Thesis/Dissertation Writing. The Quick Guide is a handy, rapid reference to get
you started in the SPS research process. Endeavor to get all the benefit each of these
resources has to offer you.

CONSIDERING YOUR RESEARCH

All culminating research at SPS is primary research, which involves collection of raw
data, processing, and analyzing the data to come up with new ideas and original
conclusions. This gives students the opportunity to:

e Develop and apply postgraduate skills of independent research, analysis,
judgment and critical evaluation.
o Refine and enhance writing and presentation skills.

e Demonstrate capacity to understand and explain strategic issues, opportunities
and/or situations within organizations.

Successful completion of primary research demonstrates a student’s mastery and
integration of theory and applications gained during his/her studies and the ability to
analyze and develop solutions to significant problems.



It is important to recognize that your research project/thesis/dissertation is the most
important artifact you create in earning your degree. It will persist in perpetuity, long
after your graduation. It also shows the extent to which you can perform critical analysis
and make sound decisions based on evidence. It is important to develop interest and
sharpen your skills in this area because there are profound future implications.

Definition of Project/Thesis/Dissertation

Students who graduate from the SPS at AUA will have demonstrated proficiency in
research through the selection and completion of a project, thesis or dissertation. Masters
level students can choose to do either a project or a thesis. Doctoral students must write
a dissertation. Each of these has a scholarly definition:

A project is considered experimental in nature; in that the researcher establishes
variables, designs interventions, and collects data to measure results of the
intervention. Students in any SPS Master’s degree programme can select to do a
project, which requires a Proposal Defence, but not a Final Oral Defence. A project
is supervised by a Primary Adviser and a Secondary Adviser. A project has an applied
aspect to it and can include the production of a manual, handbook, training or
workshop as part of the study process or outcome. For the Master of Science in
Applied Computer Science, a project must lead to the implementation of a software
product/tool that aims at solving a problem which is judged worthy of a research
project.

Typical project length: 70-80 pages excluding appendixes

Typical Computer Science project length: 45-80 pages excluding appendixes

A thesis is research that is more theoretical in nature, in that the researcher seeks to
establish a theory to explain an observed problem. Students who write a thesis may
also collect data and measure variables. However, the thesis may result in a theory
that can be advanced to make a contribution to the field of study. A thesis must be
defended at the proposal level and also defended before a three to six-member Final
Oral Defence Panel at the end of the writing phase. A thesis is supervised by a
Primary Adviser and a Secondary Adviser and has an External Examiner who reviews
the paper then joins the panel for the Final Oral Defence.

Typical thesis length: 90-120 pages excluding appendixes

Typical Computer Science thesis length: 60-90 pages excluding appendixes



A dissertation is highly academic, comprehensive, and widely considered the most
rigorous type of empirical research conducted by a student for a terminal degree. It is
expected to contribute new knowledge and advance scholarship in the field of study.
Students pursuing a PhD at AUA are eligible to write a dissertation. Before the
dissertation writing commences, the student must have passed the Comprehensive
Examination. The dissertation must be defended at the proposal level and also before
a five to seven-member Final Oral Defence Panel at the end of the writing phase. A
dissertation Committee comprises of a Primary Adviser and two Secondary Advisers.
There is also an External Examiner who reviews the paper then joins the panel of the
Final Oral Defence.

Typical dissertation length: 200-250 pages excluding appendixes

Typical Computer Science dissertation length: 90-180 pages excluding appendixes.

Eligibility to Write a Project/Thesis/Dissertation

Students in Masters programmes must have a CGPA of 2.75 or higher and pass
research courses taken at AUA in order to be eligible to write a project/thesis. Students
in the MScACS programme must have a CGPA of 3.00 or higher and pass research
courses to be eligible to write a project/thesis. PhD Leadership students must have a
CGPA of 3.33 or higher and pass research courses before being eligible to write a
dissertation.

Registration for Research

All research at AUA incurs course tuition and a Research Fee. These charges help
defray the expenses of research supervision and assessment.

Research Continuation

If the student does not finish the research within fifteen (15) months of the registration
date for the final required credits, he/she must register for Project/Thesis/Dissertation
Continuation, and pay the normal registration fees that accompany any registration.
Continuation is valid for twelve (12) months, and must be repeated each year until the
student finishes the research.

Research is considered completed when all of the required signatures are on the
project/thesis/dissertation Approval Page, when the Printing and Binding Form has been
signed by all required persons, and finally, when the student’s name has been submitted
to the Registrar by the Dean, indicating eligibility for degree conferral/graduation.



RESEARCH SUPERVISION AND ASSESSMENT TEAM

Research project/thesis/dissertation is a major undertaking in a student’s academic
life and subjected to the most rigorous levels of scrutiny in order to ensure a high
standard for the degree to be awarded. Therefore, students do not work through the
research process alone. The SPS requires research project/thesis/dissertation to be
examined by a team— Advisers, Programme Leader (PL), Ethics Committee and
External Examiners (members of other university faculty) among others. This section
gives a brief overview of the team involved in supervising and examining research work
and their role.

1. Programme Leader - The PL provides an oversight supervision of the entire
research process and acts as a moderator and quality control regulator. He/she
receives and processes the Research Proposal/full paper through the appropriate
committees. The Programme Leader also checks to make sure that all
coursework is completed and monitors the student’s research progress until
graduation.

2. Advisers — Research Advisers are usually classified into two — primary and
secondary who are mostly drawn from SPS faculty, AUA faculty and faculty
from sister universities worldwide. The Advisers are responsible for directing
and helping the student acquire the skills and knowledge necessary to plan and
conduct an original research from the initial stage of the proposal development
to the completion of the full project/thesis/dissertation. Most students and
advisors communicate to work together effectively via face-to-face meetings,
email exchanges backed up by occasional Skype chats and/or telephone
discussions.

3. Graduate Research Assistant - The Graduate Research Assistant (GRA)
primarily provides technical support to students in their research work in the
form of data analysis, interpretation, and academic writing. He/she reviews
student research papers from the Programme Leaders for assistance
and explains research issues to students.

4. Ethics Committee — The Institutional Ethics Review Committee (IERC) seeks
to establish a culture of research ethics among students that is demonstrable in
its respect for human participants and high research standards. The IERC will be
key in reviewing protocols, approving the use of ethical protocols, and assisting
students with the training in human protections necessary to safeguard human
participants. Inherent in the IERC role of ethics review and approval is the need
to consider dignity, safety, rights, autonomy, beneficence, justice, health and
well-being of participants and researchers.



10.

11.

Project/Thesis/Dissertation Committee and Panel - The
project/thesis/dissertation Committee and the Final Oral Defence Panel are
quality control regulators for the project/thesis/dissertation. The main duties of
the Committee and Panel revolve around the review, evaluation and grading of
the Research Proposal/final submissions.

External Examiner - The External Examiner is a member of the faculty of
another university appointed to evaluate the thesis/dissertation in detail before
the Final Oral Defence. He/she normally assesses the final research to determine
the readiness of the thesis/dissertation to be defended by the student. The
External Examiner submits an official report of his/her evaluation of the paper
to the Chair of the Defence Panel and is also a member of the panel that examines
the student during the Final Defence.

Research Director — The Research Director works primarily with the
Programme Director and in collaboration with the Editor and Dean to guide the
student through the final approval stages in the writing of the
project/thesis/dissertation. The Research Director reviews the paper after it is
submitted by the PL and places it into editing when it conforms to AUA
standards, style and format. Following editing, the Research Director sends the
paper to the Programme Leader for final signature from the Dean. The Research
Protocol gives additional details for papers with issues that prevent editing.

AUA Editor - The Editor’s role in working with student research is primarily
to check that the project/thesis/dissertation writing and formatting was done
correctly. It is not the role of the AUA Editor to correct all of the student’s
mistakes; excessive or factual errors will result in the paper being returned to the
student for corrections by the PL. The Research Protocol gives additional details
for the process when excessive editing errors are present in a paper.

Head of Department - The Head of Department (HOD) of the student’s degree
programme is a member of both the Proposal and the Final Oral Defence Panels.

Dean — The Dean is a member of both the proposal and the Final Oral Defence
Panels. The Dean is also responsible for the final approval of a
project/thesis/dissertation, which is shown by his/her signature on the Approval
Page and on the Printing and Binding Form.

Student - Even though a student has a whole team to help with his/her research,
the work is the student’s responsibility, not that of the research advisors, PL,
committee, panel, Research Director or Editor. The student takes full ownership
and responsibility for the ideas, statistical design and analysis, grammar/editing,
and referencing of the project/thesis/dissertation. In summary, students must
strive for high levels of academic achievement and contribute to the intellectual
life of the University.



AVOIDING PLAGIARISM

Plagiarism is using someone else’s words or ideas as if they were one’s own. It is
equivalent to intellectual thievery. Plagiarism is a serious research violation. The School
of Postgraduate Studies has zero tolerance against submission of any work containing
any amount of plagiarized material.

Plagiarism is not limited only to textbooks, but also includes media resources,
laboratory experiments and results, ideas expressed orally, artistic work, and all
copyrighted materials. At AUA, plagiarism includes all of the following:

1. Any form of copying of ideas or concepts—intentionally or out of
carelessness—and presenting them as one’s own, without crediting the author(s)
and/or proper citing/quoting (e.g. without quotation marks and a reference).

2. Copying a sentence, paragraph or section (anything more than two words) word-
for-word, or even using paraphrasing that is too much like the original. The same
rules apply if it is an electronic source, if no author is listed, or if the copyright
is expired.

3. Borrowing an idea from someone else or even from one’s own earlier work
without giving proper acknowledgement. A fact that is generally considered
common knowledge may be used without a reference.

4. Unfair use, that is, indiscriminate use of too much material from a source, even
if properly quoted and credited.

Turnitin is an anti-plagiarism software that is available for use by students of AUA.
Students are encouraged to check their papers for plagiarism by using Turnitin prior to
submitting written work to Advisers. Generally, the similarity/originality index should
be less than 20%. They should not select the repository option when running the paper
through Turnitin so that it will not be stored in the database.

Plagiarism attracts severe penalties. The penalties may take the form of failure of the
paper or suspension, or even expulsion from the University. The University also reserves
the right to revoke the degree of a student whose work has been proven plagiarized or
academically dishonest. For the complete policy, refer to the Academic Bulletin section:
Academic Integrity.



PROJECT/THESIS/DISSERTATION
PROGRESSION CHECKLIST

1. Choice of Topic

During the research class.

2. Approval of Topic

After the research class (presentation required).

3. Appointment of
Project/Thesis/Dissertation Advisers

PL identifies and appoints advisers; Dean
processes Adviser Contract.

4. Proposal Writing

Student to work with the Adviser(s) throughout
the writing process, not only at the end.

5. Proposal Defence

After approval from Advisers; if research
includes human participants, informed consent
and research instruments must be submitted at
Defence; IERC must approve instruments before
data collection begins.

6. Approval of Proposal

After Proposal Defence, revisions and signed
correction form.

7. Authorization to Collect Data

After Proposal Defence and following the
approval of corrections by the Advisers/PL.

8. Pilot Study (where applicable)

Before data gathering.

9. Actual Data Collection

Researcher receives authorization to collect data
from PL.

10. Data Analysis

Assisted by statistician/methodologist  for
qualitative and quantitative  studies in
coordination with the primary and Secondary
Advisers.

11. All 5 chapters written

Researcher.

12. Project Submission

Advisers approve.

13. Thesis/Dissertation Final Oral

Defence

After External Examiner’s assessment and

feedback.

14. Approved Project/Thesis/Dissertation

After Final Oral Defence, revisions, signed
correction form and PL verification.

15. Final Research Review and Editing

Research Director and AUA Editor.

16. Final Approval of
project/thesis/dissertation

Signature of the Dean.

17. Production of AUA Library bound
copy/soft copy and specifications for
the bound copy

Office of the Dean.







CHAPTER 2

The Proposal Stage and the
Proposal Defence






THE RESEARCH PROPOSAL

The Research Proposal stage marks the start of the application of the skills and
knowledge the student has acquired during his/her studies. Upon successful completion
of the research courses in the degree programme, students will be required to prepare a
Research Proposal on a topic of their choice.The Research Proposal is a very important
part of the research exercise because it communicates a researcher’s plan for a study and
is the first major piece of work the student has to put forward for close scrutiny by the
Proposal Committee before he/she can continue with the research study.

A word to students in the Applied Computer Science programme: In accordance with
the SPS Research Handbook, each project/thesis/dissertation starts with the proposal
formulation and defence. However, the Computer Science program does not strictly
follow the general outline of the social sciences.

For both the proposal and final project/thesis paper, the writing style is based on
predefined templates which are derived from the best practices in writing for Computer
Science and related fields of study. The templates used incorporate the following:
formatting, in-text citations, references, tables, figures, etc. While students are free to
use any writing software (e.g., Word, Pages, OpenOffice, LaTeX/BibTeX), students are
strongly encouraged to use LaTeX/BibTeX.

Computer science students are strongly encouraged to familiarize themselves with
the entire SPS Research Handbook, paying particular attention to the sections pertaining
to Computer Science which are clearly designated.

THE PROPOSAL STAGE: Process for
Projects/Theses/Dissertations

1. After the designated research course is completed and passed, each student is
assigned a Primary Adviser and a Secondary Adviser by the Programme Leader
(PL) in consultation with the student, the Head of Department (HOD), and the
Dean. In the case of a Project, the Secondary Adviser may be assigned later in
the work.

2. The student, with the assistance of the Advisers, develops a Proposal by
following the proposal and research design guidelines found in the SPS Research
Handbook.

3. When the Advisers approve the Proposal and sign the Proposal Examination
Form, a Proposal Defence Panel is formed by the PL, in consultation with the
HOD and the Dean, for the Proposal Defence by the student.

o For a Project or Thesis: The Proposal Defence Panel will consist of the two
Advisers, designated programme faculty, the PL, HOD, and the Dean.
Typically, the PL serves as the Chair.
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o For a Dissertation: The Proposal Defence Panel will consist of the Primary
Adviser, two Secondary Advisers, and designated programme faculty, the
PL, HOD, and the Dean. Typically, the PL serves as the Chair.

4. A student will defend the Proposal only when the method of data collection is
clearly described, the instrument(s) of data collection is presented, and Ethics
Clearance has been obtained. To initiate Ethics Clearance, the student submits
the paper, along with the Informed Consent and all research instruments to the
IERC after these have been approved by the PA and the PL. The results of the
Ethics Review will be communicated to the PL in writing by the IERC Chair
and a copy of the Clearance will be given to the student for inclusion in the
project/thesis/dissertation.

5. In conjunction with the Ethics Clearance process, the Proposal and research
instruments will be reviewed by the AUA Editor for formatting and writing style
as per the SPS Research Handbook. Comments from the Editor will be given to
the PL so that they can be brought to the student’s attention.

6. After the Proposal is assessed and approved by the Proposal Defence Panel,
using the Research Proposal Evaluation Form, the student is informed of the
outcome of the Proposal Defence by the PL in writing with the Proposal
Evaluation Result Form. If no corrections are necessary, the student is
authorized to collect data and continue the research process under the
supervision of the Advisers. If corrections are needed, the student cannot begin
collecting data until the revisions are completed and approved. The student is
expected to incorporate all the suggestions of the Proposal Defence Panel under
the guidance of his/her Adviser(s). Submission of the revised proposal should
not take longer than three (3) months after the Proposal Defence.

o After revision, the Advisors verify that all the corrections have been duly
incorporated into the revised proposal, using the Correction Confirmation
Form.

o The Primary Advisor then sends the revised proposal directly to the PL who
confirms the revision and officially authorizes the student to collect data and
continue the research process under the supervision of the Advisers.

Note that if, during the Proposal Defence, changes are recommended by the Panel

that affect the ethics clearance, the student is not authorized to collect data. Instead, the
student must re-submit the proposal to IERC and obtain a new ethical clearance.

14



Obtaining Research Permit

Upon receiving permission from the AUA IERC to initiate data collection, the student
is also required to:

o Apply for authority to conduct research in the country where he/she plans to
conduct the study, if applicable to country regulations. All researchers who
plan to conduct research in Kenya are required to file an online application to
the National Commission for Science, Technology, and Innovation through
this website: http://oris.nacosti.go.ke/

¢ Inaddition, where applicable, obtain permission from Officers or Management
where the student plans to collect data through questionnaires, interviews, etc.
for the study.

¢ Individual permission, by use of an Informed Consent, must still be obtained
even if the organization’s officers/management give consent.

15



Contents of the Project/Thesis Proposal

Generally, the Research Proposal for a project/thesis/dissertation is made up of three
chapters, with appendixes and references:

CHAPTER
1. INTRODUCTION

Background of the Study

Statement of the Problem

Research Questions or Objectives

Hypotheses, Null and Alternative (if applicable)
Conceptual/Theoretical Framework of the Study
Significance of the Study

Scope and Limitations of the Study

Operational Definition of Terms

2. REVIEW OF RELATED LITERATURE

Relevant Literature
Related Studies

3. METHODOLOGY

Research Design

Population and Sampling Procedure

Instrument(s) for Data Collection
For quantitative research: Instrument validity and reliability
For qualitative research: Trustworthiness of instrument, data, and/or
findings

Data Collection Procedure

Method of Data Analysis

Ethical Considerations

REFERENCES

APPENDIXES
Research Instrument(s) (questionnaires, surveys, interview guide, focus group
questions, etc.)

Informed Consent Form and Permission Letters
Institutional Ethics Review Committee Approval

16



Contents of the Project/Thesis Proposal for
Applied Computer Science Programme

For Computer Science students, the proposal document follows the structure below:

CHAPTER

1. AREA OF RESEARCH
Overall purpose of the research
Research question (main question)
Support questions
Scope of the project/thesis
Benefits of the study and Expected results

2. METHODOLOGY
Indicate the nature of the research to be done: empirical, theoretical,
experimental, or simulation
Indicate the theories, tools and technologies that will be involved in the study
Indicate how the expected results will be evaluated and benchmarked, where
applicable

3. CHAPTER OUTLINE
List of the chapters of the project/thesis

4. SCHEDULE (plan with dates of the work)
Give the main milestone of the research
For each milestone, indicate dates (estimated starting and ending dates)
Indicate if specific resources are required for the milestone, and how those
resources will be made available for the research

PRELIMINARY REFERENCES

Provide list of scholarly referenced resources that will support the research

17



Contents of the Dissertation Proposal
CHAPTER
1. INTRODUCTION

Background of the Study

Statement of the Problem

Research Questions or Objectives

Hypotheses, Null and Alternative (if applicable)
Conceptual or Theoretical Framework
Significance of the Study

Scope, Limitations and Assumptions of the Study
Operational Definition of Terms

2. REVIEW OF LITERATURE
Relevant Literature from related studies
3. METHODOLOGY

Research Design
Population and Sampling Procedure
Instrument(s) for Data Collection
For quantitative research: Instrument validity and reliability
For qualitative research: Trustworthiness of instrument, data, and/or findings
Data Collection Procedure
Method of Data Analysis
Ethical Considerations

REFERENCES

APPENDIXES
Research Instrument(s), (questionnaires, surveys, interview guide, and focus
group questions, etc.)

Informed Consent Form
Institutional Ethics Review Committee Approval

18



DETAILED CONTENTS OF THE PROPOSAL

Research Topic/Title - The first step in the research process is to identify a topic. This
is the title of the study and should reflect an area of interest to the student. The topic
must also possess potential for academically rigorous research and answer the question:
So what?

CHAPTER 1

INTRODUCTION

This chapter introduces the entire study and justifies the study by highlighting the gap
in the existing knowledge and how the present study will attempt to bridge the gap. The
primary goal of this chapter is to catch the attention of the readers through the following
elements:

a.

Background of the Study: This section serves as the introduction and provides
the reader with the essential context needed to understand the research problem.
It describes the research problem with reference to the existing literature. The
background information should indicate the root of the problem being studied,
appropriate context of the problem in relation to theory, research, and/or
practice, its scope, and the extent to which previous studies have successfully
investigated the problem, noting, in particular, where gaps exist that your study
attempts to address.

Problem Statement: The statement of the problem is the focal point of the
research investigation. A research problem may be defined as an area of concern,
agap in the existing knowledge, or a deviation in the norm or standard that points
to the need for further understanding and investigation. This section should
clearly define and articulate the problem to be addressed and indicate the need
for a study. It should describe the gap that exists between the real and the desired
or a contradiction between principle and practice which the study intends to fill.

Research Questions or Objectives: This section should contain a clear statement
of the research objectives questions. Research Objectives are the goals which
the research is supposed to attain and there can be one general objective and a
corresponding number of specific objectives which are derived from the general
objective. Alternatively, the researcher can pose research questions. Research
questions are those that the researcher would like to specifically answer in the
study. Thus, the research problem is broken down into a series of
guestions/objectives concerning the relationship between the cause (independent
variable) and the effect (dependent variable). The researcher may write
objectives instead of research questions, as his/her department may require.
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Null Hypotheses: A research hypothesis is a tentative statement of a potential
relationship between two or more variables or a potential difference between
two or more groups expressed in the form of a clearly stated relation between
the independent variable(s) and dependent variable(s). Hypotheses requiring
statistical testing are stated in negative form and are, therefore called “null
hypotheses.” These are formulated after a thorough review of the literature. The
research hypotheses should relate to the aims and objectives. The hypothesis is
accepted or rejected depending on the results of the statistical tests. All
inferential research questions (or objectives) require null hypotheses to be stated.

Conceptual Framework: A conceptual framework is the detailed presentation of
the variables/constructs that support and guide the research. It explains, either
graphically or in narrative form, the main issues to be studied—the key factors,
concepts, or variables—and the presumed relationships among them. A
schematic diagram of conceptual model helps the reader to visualize the
theorized relationships between the variables in your model.

Significance of the Study: This section explains the rationale for why the study
is important and how it will contribute to professional knowledge and practice.
What is the value of your work—who might be able to use it? The significance
of the study addresses (1) why your study is important, (2) to whom it is
important, and (3) what benefit(s) will occur if your study is done. This should
be limited to a couple of paragraphs.

Scope and Limitations of the Study: The scope defines the boundaries of the
research in terms of the depth and breadth of your study. The selectedvariables,
population/sample, etc. can determine the scope. The limitation of the study
identifies potential weaknesses of the study. The student should identify and
precisely list the limitations of the study and discuss the extent to which the
limitations would affect the quality of the research. If any limitations can be
mitigated, state how this will be done.

Assumptions of the Study: PhD students are required to discuss the underlying
assumptions of their study. Assumptions reflect important issues surrounding
the study which the researcher believes to be true. The most obvious is that the
sample represents the population. Another common assumption is that an
instrument has validity and is measuring the desired constructs. Still another is
that respondents will answer a survey truthfully. The important point is for the
researcher to state specifically what assumptions are being made.

Operational Definition of Terms: This section defines/explains key
terms/variables used in the study that do not have a commonly understood
meaning and those that have been operationally defined in the context of the
study.
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CHAPTER 2

REVIEW OF RELATED LITERATURE

Before planning the details of a study, the researcher should dig into the literature to
find out what has been written about the topic he/she is interested in investigating. The
idea is that the student reads the literature base and critically evaluates it to produce a
balanced review. Both the opinions of experts in the field and other research studies have
a significant bearing on the problem under study. Therefore, Chapter 2 is usually
reasonably long and organized by theme, subtopic, or variable based on the conceptual
framework of the study.

The literature review should cite similar studies that lead up to the current research.
The student should seek to synthesize findings across studies and compare and contrast
different research outcomes. It is important to note gaps or shortcomings in the literature
S0 as to provide a rationale for the current study. A typical Literature Review section
begins with definitions and theoretical discussions, a review of research that has already
been done in this area and a theoretical framework. PhD students are required to include
a theoretical framework in addition to the conceptual framework in their proposal. A
student who thinks critically will not only look for and cite literature that supports his/her
study perspective, but will also present literature that takes an opposite or conflicting
view. When this is skilfully and impartially done, the value of the study is enhanced.
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CHAPTER 3

METHODOLOGY

The Methodology chapter is very important because it tells your Research Committee
how you plan to tackle your research problem. The guiding principle for writing the
Methodology section is that it should contain sufficient information for the reader to
determine whether the proposed methodology is sound. Therefore, Chapter 3 describes
and justifies the research methods which the studentplans to utilize in her/his
investigation. This includes a description and justification of the research design, target
population and sampling technique, the instruments to be used, the procedures to be
followed, an identification of threats to internal validity, ethical considerations and a
description and a justification of the statistical procedures used.

a. Research Design: The research design provides the framework and structure
within which a particular research study is conducted. Examples of research
design include the following types: descriptive, ethnographic, causal, action
research, and cross sectional, etc. Descriptive statistics, while appropriate for a
project, are not sufficient for a thesis or dissertation which requires some form of
inferential statistics or sufficient qualitative data to develop a theory or
confirm/modify an existing theory. Research methods may be qualitative,
quantitative, or a combination of both, which is known as mixed methods.

b. Population and Sampling Procedure: This section discusses the target population
and how the sample was selected. The reader of your paper will want to know
whether the sample you have chosen is representative of the entire study
population. Representative samples are important for drawing insights and
generalizing the findings for the entire population. The unquestionable way of
achieving representative samples is to use probability (random) sampling
methods. The student should also describe the procedures for selecting the sample,
including the sampling technique and state how the sample size was determined.
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C.

Instruments: These are the tools used to obtain information from respondents.
Examples include questionnaire, interview, observation, and reading of
documents. Describe the instruments you intend to use. Be sure to design your
instrument(s) based on your research questions/objectives and/or test hypotheses.
For each instrument you did not make yourself be sure to show your permission
to use the instrument, give reliability numbers from past uses of the instrument(s),
and include a proper reference for it. If you have adapted the instrument, tell
WHAT you changed, WHY, and HOW. If it is a substantial change, you may have
to pilot test the instrument again and provide reliability numbers. If you are going
to develop a new questionnaire, how you design the items is very important. They
should not favor any biases you may have; they should not lead the respondent to
an answer and, typically, a new questionnaire should be pilot tested and validated
in order to evaluate if it is measuring what it is supposed to measure and doing so
reliably.

i. Instrument Validity (used in quantitative research) —Validity refers to the
accuracy or truthfulness of a measurement. There are at least three types of
validity that should be addressed and you should state what steps you took to
assess validity. (1) Face validity refers to the likelihood that a question will
be misunderstood or misinterpreted. Pilot testing of a questionnaire is a good
way to increase the likelihood of face validity. (2) Content validity refers to
whether an instrument provides adequate coverage of a variable/concept.
Expert opinions help to establish content validity. (3). Construct validity
refers to the theoretical foundations underlying a particular scale or
measurement. The researcher should describe the criteria used to validate the
construct. A technique known as confirmatory factor analysis is often used
to explore how individual survey items contribute to an overall construct
measurement. PhD students are required to conduct construct validity in
addition to face and content validity.

ii. Instrument Reliability (used in quantitative research) — A measurement that
yields consistent results over time is said to be reliable. There are different
statistical analyses for testing reliability depending on the type of data.
Researchers must use the appropriate statistical technique in testing for
reliability.

iii. Trustworthiness—(used in qualitative research) Trustworthiness is a way of
evaluating rigor in qualitative research. Typically, there are four aspects of
trustworthiness that a researcher must establish: 1) credibility; 2)
dependability; 3) transferability; and 4) confirmability. There are various
methods used to establish these aspects, such as triangulation of data sources,
participant-checking, and peer/content expert input or review of
instrument(s), data or findings. Note that qualitative research does not
generally use the measures of instrument validity and reliability.
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iv. Translation— Translation of the original instrument(s) into one or more
additional languages may be necessary if the population sample cannot
adequately comprehend and respond to the instrument in the original
language (usually English). In this case, translation is required and the
student MUST describe the specific method of translation. Also, the initial
translation from the original language to the target language(s) should be
made by at least one independent translator/interpreter before the
instrument(s) is subjected to validity and reliability analysis. A copy of the
research instrument(s) should be included in the appendixes. Note: all
documents that appear in the appendixes in a language other than English
must appear with an English version.

d. Data Collection Procedure: Describe your data collection procedures in the exact
sequence in which you carried them. How will you actually go about it? Will you
seek permission from the relevant authorities? When and where will the data
collection take place? Will you personally collect the data or employ the services
of research assistants/enumerators? How will you conduct the interviews or focus
group discussions (if any)? If you are doing an ethnographic study or population
observation, how will this proceed? If you use research assistants and/or
enumerators, how will you choose them? How will they be trained so as to comply
with your research methods? If they are paid or incentivized in any way, it is
professional to discuss this. Also, describe any special procedures that will be
followed (e.g., instructions that will be read to participants, presentation of an
informed consent form, etc.).

e. Method of Data Analysis: Data analysis involves the application of the appropriate
statistical tools and/or qualitative methods to generate results which can be
meaningfully used to answer the research questions and/or test hypotheses. The
choice of a particular statistical tool(s) depends on the type and level of data,
hypothesis statements, and the requirements and assumptions of the statistical
tools. If the data only requires qualitative analysis, descriptive tools such as
content analysis can be used. If you are doing an intervention, discuss the exact
way your data analysis will support the design of your intervention. In this section,
include the decision-making criteria (e.g., p-value, scoring of means, etc.) as well
as the statistical software that will be used, which is typically given an inline
citation or simply state the version of the number of the software. If your statistical
analysis is complicated or you are not confident of your abilities, consider hiring
a statistician.
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f. Ethical Considerations: Ethical issues are an area of great concern in social
research. If your study population consists of humans or animals, or creates a
situation which could affect them, it is necessary to obtain approval for your
research study before collecting any data. This section must clearly discuss any
potential risks relating to the participants in your study. Potential or actual risk can
be physical, mental, social, or emotional in nature, so think broadly about potential
risks. Your paper should describe how you will reasonably minimize risk to
participants—do not just state that you will avoid risks to participants—you must
have safeguards in place at the start of your study. Explain in detail how you will
secure informed consent, maintain anonymity, support confidentiality, and what
you will do with the data once you are done with it. Research ethics also demands
that researchers report findings objectively, accurately, and acknowledge all data
sources in the research report. This section should also contain appropriate
permissions for photography, direct quotation of participants and any potential use
of personally identifiable information in the written report if anonymity is
promised.
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REFERENCES

The School of Postgraduate Studies at AUA uses American Psychological
Association (APA) style for their research. This includes term papers and class
assignments, projects, theses and dissertations.

A reference list provides a complete description of the sources cited in the
proposal/report. Each reference cited in the main work must appear in the reference list,
and each entry in the reference list must be cited in the text. As far as possible, references
used in the paper should be current—within the past five years. Students are encouraged
to minimize the use of internet webpage articles. Peer-reviewed journal articles and
books are considered more academic for references than are unpublished works or non-
peer-reviewed journal articles. The APA reference list must match the citations used in
text EXACTLY. There are many useful web sites that give information on compiling
your references, such as: http://aut.ac.nz.libguides.com/APAG6th/referencelist.

APPENDIXES

This section is the appropriate place for all the supportive documents/materials that
substantiate the study. Appendixes are usually grouped by type of material, and each
individual item does not need a separate subtitle. Common appendixes include
correspondence such as Letters of Authorization from AUA, ethics committee approvals
and other relevant institutional documents, should be attached as appendixes to show
that the researcher obtained all the needed approvals to conduct the study. In addition,
the research instruments, statistical analyses, etc., are appended and labelled.
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THE PROPOSAL DEFENCE

Proposal Defence examination is an integral part of the proposal assessment process.
Each student has to orally defend his/her proposal before a panel of experts/professors
from the SPS to assure the Panel that the proposed research is relevant and interesting.
Additionally, it is to assure that the study design is sound and that the researcher is
capable of successfully conducting the study. Upon meeting the proposal requirements,
a Proposal Defence Panel is formed by the PL, in consultation with the Dean within two
weeks. The Research Proposal Defence schedule is usually provided to each student at
least a week before the Defence, detailing the venue, time and duration of the defence.
Refer back to the Research Protocol for specifics of the Proposal Panel.

The Research Proposal should be orally defended to a Panel of Examiners, using
PowerPoint presentation. Usually, students are given 20 minutes for presentation and 40
minutes for cross examination from the evaluation panel and the audience. Table
1belowpresents sample contents of the proposal presentation and some tips.
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Table 1. Sample Distribution of Slides and Tips for Presentation Slide Show

Presentation Content Number Note
of Slides
Title Slide 1 Include Title of the Research Proposal, Program

of Study, Name of the Student and the date

Introduction 2-3 Brief background of the Study

Problem Statement 1-2 Important to establish a problem clearly and
definitively

Research Questions/ 1-2 Research questions should be related to the topic

Obijectives and be answerable within the time frame of the

Quantitative Studies: study. Findings should relate back to research

Hypotheses guestions

Qualitative Studies: Typically 3-5 research questions are adequate

Do not use hypotheses

Conceptual/Theoretical 1 Project the diagram/figure

Framework

Literature Review 2-3 Briefly present the key literature reviewed

Methodology 2-5 Include the research design, population, sample

size determination and sampling method,
instruments and method of data analyses. (2-
5slides)

Question/Answer Time 1

Formatting
Don’t put too much information on one slide. Each slide should have no more than 7 lines.

Avoid font size smaller than 24 points. Titles/Headings can have as large as 32-40 points in
size. Bulleted lists are effective at 24-28 points.

Use simple backgrounds that produce high contrast. Use either a dark background with light
letters or a white background with dark letters.

Other Presentation Tips

Do not read the presentation to the audience. Reading a presentation word-for-word shows
lack of confidence and familiarity with the study.

Arrive early (at least 15 minutes before schedule) and present within the allotted time. Arrive
early enough to test the presentation and familiarize yourself with the room and equipment.

Pay attention to other details such as typographical and grammatical errors in the
presentation, as well as to how you dress, your mannerisms and basic courtesy during
presentations. The appropriate dress for a Defence is professional, whether the setting is via
conferencing or face-to-face. It is courteous to thank your committee/panel, either at the start
of the defence or at the end.

Don’t put effects into your presentations, such as sounds, animations, and distracting slide
transitions. A simple, well-planned presentation is most effective.
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On-line Conferencing Proposal Defence Tips

A significant number of SPS Proposal Defences are carried out by video conferencing
due to the cost of travel. In such cases, the appropriate IT people set the link up and then
the defence is carried out in exactly the same way it would be conducted on campus.
Students who opt for the online Proposal Defence should consider the following to
facilitate a smooth conference:

o Speak slowly and clearly.
o Make sure each person present can hear everybody else.

o Allow for a transmission time lag. This can be up to 2 seconds over very long
distances.

¢ Always assume it is going to take longer than planned to set up the video link.

e Ensure there is no background noise, especially from nearby traffic and air-
conditioning systems.

e Make sure that the latest approved copy of your proposal has been sent to your
Programme Leader before the Defence in order for your Panel to review your
paper before the Defence. Inform your adviser(s) of any substantive changes and
get his/her approval.

Proposal Post-Defence Requirements

If no post-defence corrections are required, the student can begin to collect data. If
corrections are required, they must be completed in the time frame given by the panel.
Refer back to the Research Protocol for the post-defence steps.

Forms for the Proposal Stage

Below is a listing of the Samples, Forms and Grading Assessments that are used in
the Proposal Stage. All of these documents are located in Chapter 9 of this SPS Research
Handbook for your convenience.

Some of these documents are generated by the student, some by the Programme
Leaders, Advisers or Examiners. Review each form so that you are familiar with them
and how they are used. In the case of Grading/Assessment/Evaluation forms, these are
provided so that you know what is expected of your work, which will help you in
planning, writing and defending your project/thesis/dissertation.
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Give attention to the title of the documents so that you know whether it is used for a
project or a thesis or a dissertation.

Forms

v" Informed Consent
Parent or Guardian Permission Form for Research Involving a Minor
Non-Disclosure Agreement for Participants in Interviews or Focus Groups
Permission to Use Direct Quotations for Interviews or Focus Groups
Permission for Photography/Any Pictures Taken by Researcher
Proposal Examination Form
Research Proposal Defence Evaluation Form
Research Proposal Defence Evaluation Form for Computer Science

Proposal Defence Evaluation Result Form

AN N N N N Y N NN

Proposal Correction Confirmation Form
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CHAPTER 3

The Writing and Final Oral
Defence Stage






WRITING, DEFENDING AND SUBMITTING THE
RESEARCH PROJECT/THESIS/DISSERTATION

The first three chapters of the project/thesis/dissertation are essentially the same three
chapters of the proposal and have been covered previously. The difference, however, is
that the proposal speaks in the future tense to show how the researcher intends to carry
out the research—it outlines the proposed plan of the research. However, after the data
is collected and analyzed, the researcher must focus on the reporting of the research,
which requires entrance into the writing stage. Now the researcher builds on the
approved proposal and reports (in past tense) what was done, rather than what he/she
plans to do, and he/she includes the actual results of the study. This part details the entire
research process that the student went through to find answers to the research problem.

Again, the Research Protocol is given for an overview of the steps in the process.
Notice that the Research Protocol numbering begins afresh in each section. If you want
to view the complete Research Protocol, it is found at the end of the SPS Research
Handbook. Following the Protocol, information is given to organize and structure the
full research report. Note that processes are specific to whether the paper is a project,
thesis, or dissertation.

THE WRITING STAGE: Process for Projects

All SPS students must ensure that their citations follow the American Psychological
Association (APA) style and that their writing and formatting conform to the SPS
Research Handbook.

1. The student submits each chapter of the Project to the Primary Adviser who assists
the student to reach the highest level of research and writing quality, and also
advises of areas that are incorrect, non-conforming to style, or are weak and need
modification. When the student has corrected all indicated areas to the satisfaction
of the Primary Adviser, the Primary Adviser provides written approval to the
student. Approval from the Primary Adviser affirms that the Project adheres to
academic research standards and SPS Research Handbook. The Primary Adviser
should copy the PL on all correspondence to the student.

2. After the Primary Adviser approves the Project, it is returned to the PL. The PL
then assigns the Project to the Secondary Adviser, who provides another critical
reading of the work and recommends any additional modifications to the student.
When this process is completed to the satisfaction of the Secondary Advisor,
he/she gives the student written approval and completes the Project Examination
Form. Then the Secondary Adviser sends the Project back to the Primary Adviser
to check the changes.
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The Primary Adviser gives approval of the paper and completes the Project
Examination Form, which is submitted to the PL, along with the paper.
Students should not submit approved Projects directly to the PL.

3. The PL requests grades for the Project from the Primary and Secondary
Advisers by sending them the Grade Form for Advisers.

THE WRITING STAGE: Process for Theses

All SPS students must ensure that their citations follow the American Psychological
Association (APA) style and that their writing and formatting conform to the SPS
Research Handbook.

1. The student submits each chapter of the Thesis to the Primary Adviser who assists
the student to reach the highest level of research and writing quality, and also
advises of areas that are incorrect, non-conforming to style, or are weak and need
modification. When the student has corrected all indicated areas to the satisfaction
of the Primary Adviser, the Primary Adviser provides written approval to the
student. Approval from the Primary Adviser affirms that the thesis adheres to
academic research standards and the SPS Research Handbook. The Primary
Adviser should copy the PL on all correspondence to the student.

2. After the Primary Adviser approves the thesis, it is returned to the PL. The PL
then avails the thesis to the Secondary Adviser, who provides another critical input
to the work and recommends any additional modifications to the student. When
this process is completed to the satisfaction of the Secondary Advisor, he/she
gives the student written approval and completes the Thesis Examination Form.
Then the Secondary Adviser sends the thesis back to the Primary Adviser to check
the changes.

3. The Primary Adviser gives approval of the thesis and completes the Thesis
Examination Form, which is submitted to the PL, along with the thesis. Students
should not submit an approved thesis directly to the PL.

THE WRITING STAGE: Process for Dissertations
All SPS students must ensure that their citations follow the American Psychological

Association (APA) style and that their writing and formatting conform to the SPS
Research Handbook.
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1. The student submits each chapter of the dissertation to the Primary Adviser who
assists the student to reach the highest level of research and writing quality, and
also advises of areas that are incorrect, non-conforming to style, or are weak and
need modification. When the student has corrected all indicated areas to the
satisfaction of the Primary Adviser, the Primary Adviser provides written
approval to the student. Approval from the Primary Adviser affirms that the
dissertation adheres to academic research standards and the SPS Research
Handbook. The Primary Adviser should copy the PL on all correspondence to the
student. After the Primary Adviser approves the dissertation, he/she returns it to
the PL.

2. The PL then avails the dissertation to the two Secondary Advisers, who provide
additional critical input to the work and recommend modifications to the student.
When this process is completed to the satisfaction of the Secondary Advisers, they
both give the student written approval and complete the Dissertation Examination
Form.

3. Then the dissertation is sent back to the Primary Adviser to check the changes.
The Primary Adviser gives approval of the dissertation and completes the
Dissertation Examination Form and submits it to the PL, along with the
dissertation. Students should not submit an approved dissertation directly to the
PL.

Organization and Structure
The final project/thesis/dissertation is organized into five (5) chapters with structured

sections in each chapter. Again, there are differences between the structure of a project,
thesis, and dissertation as shown in the following:
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Research Project Outline

Abstract

Title Page

Copyright Page

Approval Page

Dedication Page (optional)

Table of Contents

List of Tables

List of Figures

List of symbols and/or abbreviations
Acknowledgements (optional)

CHAPTER
1. INTRODUCTION

Background of the Study

Statement of the Problem

Research questions or objectives
Hypotheses (if applicable)

Conceptual or Theoretical Framework
Significance of the Study

Scope & Limitations of the Study
Operational Definition of Terms

2. REVIEW OF LITERATURE

Review of literature relevant to the research study/conceptual framework.
Related Studies relevant to the research study.
v The review must be comprehensive in terms of breath (scope) and depth
(extent).

3. METHODOLOGY

Research Design

Population & Sampling Procedure

Instrument(s) for Data Collection
For quantitative research: Instrument validity and reliability
For qualitative research: Trustworthiness of instrument, data, and/or
findings

Data Collection Procedure

Method of Data Analysis

Ethical Considerations
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4. RESULTS & DISCUSSION

Study Area Setting

Response Rate

Demographic Characteristics of Respondents

Results and discussions based on the research questions

Proposed Product Development/ Program Development on the results of the
study

Product/Program Implementation and/or Evaluation (Optional)

5. SUMMARY, CONCLUSION & RECOMMENDATIONS

Summary

Conclusion

Recommendations

Suggestions for Future Research

REFERENCES

APPENDIX(ES)
Correspondence
Questionnaires
Interview guide

Statistical Analyses
Any other supplementary materials

CURRICULUM VITAE
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Research Thesis Outline

Abstract

Title Page

Copyright Page

Approval Page

Dedication Page (optional)

Table of Contents

List of Tables

List of Figures

List of symbols and/or abbreviations
Acknowledgements (optional)

CHAPTER
1. INTRODUCTION

Background of the Study

Statement of the Problem

Research questions

Hypotheses (if applicable)

Conceptual or Theoretical Framework
Significance of the Study

Scope & Limitations of the Study
Operational Definition of Terms

2. REVIEW OF LITERATURE

Review of literature relevant to the research study/conceptual framework

Related Studies relevant to the research study
3. METHODOLOGY
Research Design

Population & Sampling Procedure
Instrument(s) for Data Collection

For guantitative research: Instrument validity and reliability
For qualitative research: Trustworthiness of instrument, data, and/or

findings
Data Collection Procedure
Method of Data Analysis
Ethical Considerations
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4. RESULTS & DISCUSSION

Study Area Setting

Response Rate

Demographic Characteristics of Respondents

Results and discussions based on the research questions

5. SUMMARY, CONCLUSION AND RECOMMENDATIONS

Summary

Conclusion

Recommendations

Suggestions for Future Research

REFERENCES
APPENDIX(ES)
Correspondence
Questionnaires
Interview guide
Statistical Analyses
Any other supplementary materials

CURRICULUM VITAE
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Computer Science Research Project Outline

Abstract

Title Page

Copyright Page

Approval Page

Table of Contents

List of Tables

List of Figures

List of symbols and/or abbreviations

CHAPTER
1. INTRODUCTION

Background of the Study

Statement of the Problem

Scope and Limitations of the Project
Operational Definition of Terms

2. METHODOLOGY

The methodology should be concise to include only theories, methods, tools and
technologies that are related to the project work. It should also seek to compare,
contrast and justify the differences (approach, methods, tools and technologies)

with similar projects.

3. PROPOSED SOLUTION TO THE PROBLEM

The title of this chapter will be determined by the project aim and outcome.
This is where the student work is presented in detail.

4. RESULTS AND BENCHMARKING

This chapter presents the experimental results of the project and provides where
applicable benchmarking information of the project results.

5. CONCLUSION

Summary of the work that has been done
Discussion

Limitations

Perspectives and Future work

40



REFERENCES (IEEE Trans Reference Style)

APPENDIXES
Reference material developed and/or used in the course of the project, needful to
the understanding of the work, but not suitable to be put in the body of the
document—e.g., sample(s) of source codes.
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Computer Science Research Thesis Outline

Abstract

Title Page

Copyright Page

Approval Page

Dedication Page (optional)

Table of Contents

List of Tables

List of Figures

List of symbols and/or abbreviations

CHAPTER
1. INTRODUCTION

Background of the Study
Statement of the Problem

Research questions or objectives
Significance of the Study

Scope and Limitations of the Study
Operational Definition of Terms

2. LITERATURE REVIEW

Theoretical Review of literature relevant to the research study
Related Studies relevant to the research study. The review should seek to show
the link with the current study.

3. RESEARCH METHODOLOGY

The methodology should be concise to include only theories, methods, tools and
technologies that are related to the research work.

- indicate the nature of the research to be done; empirical, theoretical, experimental,
simulation

- indicate the theories, tools and technologies that will be involved in the study

- indicate how the expected results will be evaluated and benchmarked where
applicable

4. CONTRIBUTION (PROPOSED SOLUTION TO THE PROBLEM)

The title of this chapter will be determined by the student contribution.
This is where the student work is presented in detail.
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Depending on the level of the study contribution, an extra chapter can be added to
present and discuss the results.

5. CONCLUSION
Results and their interpretation
Discussion
Limitations
Perspectives and Future work
REFERENCES (IEEE Trans Reference Style)
APPENDIXES
Reference material developed and/or used in the course of the study, needful to
the understanding of the work, but not suitable to be put in the body of the
document—e.g., sample(s) of source codes.

CURRICULUM VITAE
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Research Dissertation Outline

Abstract

Title Page

Copyright Page

Approval Page

Dedication Page (optional)

Table of Contents

List of Tables

List of Figures

List of symbols and/or abbreviations
Acknowledgements (optional)

CHAPTER
1. INTRODUCTION

Background of the Study

Statement of the Problem

Research questions

Hypotheses

Conceptual or Theoretical Framework
Significance of the Study

Scope, Limitations and Assumptions of the Study
Operational Definition of Terms

2. REVIEW OF LITERATURE

Theoretical Review of literature relevant to the research study/conceptual
framework
Related Studies relevant to the research study

3. METHODOLOGY

Research Design
Population and Sampling Procedure
Instrument(s) for Data Collection
For guantitative research: Instrument validity and reliability
For qualitative research: Trustworthiness of instrument, data, and/or findings
Data Collection Procedure
Method of Data Analysis
Ethical Considerations
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4. RESULTS AND DISCUSSION

Study Area Setting

Response Rate

Demographic Characteristics of Respondents

Results and discussions based on the research questions
Proposed Model/Framework based on the results of the study

5. SUMMARY, CONCLUSION & RECOMMENDATIONS

Summary

Conclusion

Recommendations

Suggestions for Future Research

REFERENCES
APPENDIX(ES)
Correspondence
Questionnaires
Interview guide
Statistical Analyses
Any other supplementary materials

CURRICULUM VITAE
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REQUIRED PRELIMINARY PAGES FOR
PROJECTS/THESES/DISSERTATIONS

Each SPS research project/thesis/dissertation should have preliminary pages. These

are the initial pages that precede chapter one of the study. Preliminary pages include the
following and in this order:

b)

Abstract (approximately 250-350words)

Title page

Copyright page

Approval Page

Dedication page (optional)

Table of Contents

List of Tables (if 5 or more are used)

List of Figures (if 5 or more are used; combine on one page with
list of tables, if possible)

List of symbols and/or abbreviations (if 5 or more are used at
least 3 times each)

10. Acknowledgements(optional)

NN E

©

Abstract. The abstract is a descriptive summary of the research. A good abstract
briefly defines the research problem, the methodology, findings and brief conclusions
or recommendations of the study. Descriptions of the method may include the design,
the sample and the research instrument(s) used. At the end of the abstract, there
should be 3-5 keywords that give the main topics of the research and allow other
researchers to find your study when searching the literature.

Title page. This is the page (after the abstract) which displays the research title, name
of the author (student), purpose for which the dissertation has been submitted, the
school, university and the date research was completed or approved.

Copyright page. Copyright indicates the intellectual ownership of material. While it
is not required to copyright your research work, it is encouraged. Use of copyrighted
material is limited to (a) “fair use” or (b) licensed use. A simple copyright notice can
be done using the sample statement at the bottom of an otherwise empty page.

Approval Page. This page is signed by the members of the Panel for a Defence and
by the members of the Committee for a Project.

Dedication page. This is a statement where students may dedicate their work to
whoever they wish, such as family members, loved ones, friends, participants, etc. It
is optional and should be short.

Table of Contents. This is a paginated guide to the paper. It lists the chapter titles and
major headings that come after it exactly as they appear in the body of the document
based on the project/thesis/dissertation structure. The Table of Contents should be
generated automatically.
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i. The Table of Contents must reflect the first three levels of
subheadings used, if all are used.

ii. Each of the preliminary pages, starting at the Table of Contents, has
a page number in lower case Roman numerals at the bottom center
of the page in the same font and size as the text. Start counting pages
from the Title Page, then start printing them from the table of
contents.

iii. Page numbering in Arabic numerals is in the same font and size as
the text, beginning with the first page of Chapter One and runs

consecutively throughout the project/thesis/dissertation.

g) List of Tables. This page lists all tables in the report when five or more tables are
used in the paper.

h) List of Figures. This page lists all figures in the report when five or more figures are
used in the paper.

i) Acknowledgements. A page of Acknowledgements offers opportunity to express
gratitude to persons/institutions that have been helpful during the course of the
research study. This page is optional.
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CHAPTER 4

RESULTS AND DISCUSSION

Chapter 4 is the main contribution of the research. This chapter reports the results of

the study based on the research questions/objectives posed in Chapter 1 and provides the
basis on which the hypothesis is either accepted or rejected. Chapter 4 may be organized
as follows:

a)

b)

d)

Study Area Setting. Describe the settings/area in which the study took place. The
research setting is the study environment which can be seen as the physical, social,
and cultural site in which the researcher conducts the study.

Response Rate. The response rate refers to the proportion of the
respondents/participants who actually participated in the study survey divided by the
number of people in the sample. It is usually expressed in the form of a percentage.
The student is expected to report and discuss the response rate to determine the degree
of success in obtaining completed surveys from a sample and also discuss the possible
reasons for the response rate.

Demographic Characteristics of Respondents. An insight into the demographic
profile of the respondents gives an overview of the type of people this study has been
carried on. It is important for the researcher to present and discuss the general
characteristics of the research participants in terms of age, gender, educational level,
etc., using frequencies and percentages. Generally, respondents’ characteristics give
readers a good understanding of the sample and the generalizability of the results and
are, therefore, important.

Research questions or objectives. Organize the presentations and discussions of the
results according to the research questions/objectives/hypotheses in sequence.
Present quantitative data using figures/charts or tables (do not use both for the same
findings), and discuss the results to bring out the implications of each finding.
Literature reviewed in Chapter 2 may be cited to show how your findings are similar
or different from other studies and existing theories. Explain possible reasons why
the results might have turned out the way they did. Thus, a critical analysis and
interpretation of findings are expected in this chapter. Also, each hypothesis must be
tested based on the results and followed by a statement on action taken (acceptance
or rejection of hypotheses) with regard to the hypothesis and the implications of such
action. End the discussion with a reasoned and justifiable explanation on the
importance of your findings.

Proposed Model/Framework based on the results of the study. A doctoral dissertation
is the most rigorous type of research conducted by a student. PhD students are
expected to contribute new knowledge and advance scholarship in their field of study.
Therefore, doctoral dissertations are required to offer new/improved
theory/model/framework based on the outcomes of the study.
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CHAPTER 5

SUMMARY, CONCLUSIONS AND RECOMMENDATIONS

This chapter gives the summary of the study, conclusions drawn from the results of
the study and recommendations.

Summary

This section gives an overview of the entire study. It reiterates the statement of the
problem, rationale for the study, research questions/objectives, hypothesis (if any), the
method and the main findings. Descriptions of the method may include the design, the
sample and the research instrument(s) used. This section should not contain any new
information. Summary does not include the review of the literature.

Conclusions

The final stage of the project/thesis/dissertation is to derive final conclusions based
on the results of the study. The conclusion should be mainly related to your original
research questions, but including what you think about what was found and what it might
mean.

Recommendations

This section requires the presentation of suggestions or courses of action based on
the findings, which the end user(s) can adopt for improvement. The student is expected
to suggest appropriate measures to strengthen identified weaknesses, eliminate or solve
conflicts or introduce innovative ideas and practices to specific groups of
people/institutions (e.g. Administrators, employees, the church, etc.) that might be
impacted by his/her study.

Remember that recommendations must be based on your data; they cannot simply be
your ideas based on your own personal opinions, unrelated to your findings. Also,
research invariably uncovers more questions than it answers. Therefore, it is important
to include suggestions for further research. This is intended to identify potential research
areas that are outside the scope of the current research but that are useful and promising
areas for other researchers to develop. For example, what questions does your study
leave unanswered? What possible research areas may need closer examination? Thus,
recommendations for further research are required.
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REFERENCES

Update the References page to include only sources cited in your work upon
completion of the study. Be sure to follow APA style for references completely, and be
accurate with information.

APPENDIXES

Upon completion of the entire research report, update the appendixes page to show
correspondence, such as Letters of Permission to do the study, instruments, the statistical
raw data from which the study was written, etc.

CURRICULUM VITAE

A brief Curriculum Vitae (CV) which details the student’s personal information,
academic credentials and professional accomplishments is required for all
projects/theses/dissertations. The purpose of the CV is to familiarize readers with the
researcher’s current qualification and experience. The date of birth, place of birth,
marital status, and spouse/children’s names and number are not required on a CV, though
this information may be commonly included in some places. Do not list referees or
recommenders in CV—they will be removed before your paper is bound.

50



FINAL ORAL DEFENCE OF THE
THESIS/DISSERTATION

After the thesis/dissertation is written, the next step is participation in the Final Oral
Defence. This process can rightly be viewed as exciting because the student has the
opportunity to have his/her research on full display—along with the chance to discuss it
with persons who are committed to bringing it to the highest standard of quality and
scholarship.

Here is the overview by use of the Research Protocol. Note that there is some
variation in the Defence of a thesis and dissertation.

THE FINAL ORAL DEFENCE STAGE:
Process for Theses
1. When the PL has the approved Thesis, he/she sends it to an External Examiner.

2. After the External Examiner has reviewed the Thesis, the PL, in consultation with the
HOD and the Dean, sets a date for the Final Oral Defence.

3. The PL informs the members of the Final Oral Defence Panel that the Oral Defence
date has been set and assures the availability of members. The Final Oral Defence
Panel consists of the:

e Dean, Chair

e Head of Department

e Programme Leader

¢ Designated Faculty of the Program
e Primary Adviser

e Secondary Adviser

o External Examiner

4. Attendance at the Final Oral Defence is open to the public. Those present may
participate in directing questions to the student on the topic of his/her research, when
invited by the Dean. The audience will not be provided with a copy of the student’s

paper.
5. A Thesis Final Oral Defence shall normally be no longer than two hours and no
shorter than one hour in duration. At the start of the Defence, the student is given 20

minutes to present his/her thesis. The presentation is followed by the examination
from the Panel.
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6. Atthe conclusion of the Defence and following an executive session of the Panel, the
student is informed how the Defence was scored:

e Very Good - No corrections necessary.

e Good- Minor corrections necessary; the student may take up to one (1) month
to make the corrections and submit the revised Thesis to the Primary Adviser
through the PL.

o Fair- Major corrections necessary; the student may take up to two (2) months
to make the corrections and submit the revised Thesis to the Primary Adviser
through the PL.

e Fail- Thesis is not accepted; the student must begin the process afresh.

7. If revisions to the Thesis are necessary, the PL communicates them to the student and
Primary Adviser, along with the timeframe given to finish the revisions. This will be
provided in writing, and the student is expected to be diligent in making the revisions.
These revisions are done in consultation with the Primary Adviser who then confirms
that all the revisions have been done satisfactorily and submits the Final Thesis
Correction Confirmation Form, along with the Thesis to the PL.

Format of the Final Oral Defence

The Final Oral Defence for a Thesis is generally no longer than two hours and no
shorter than one hour in duration. The researcher has 20 minutes to present a PowerPoint
presentation. Then the Panel takes approximately 40 minutes for cross examination. The
Defence is open to students and supporters to attend, and they may ask questions or make
input, but on a limited basis at the discretion of the Chair. The audience will not be
provided with a copy of the student’s paper. Refer back to Table 1 for presentation and
formatting tips and to Table 2 (below) for the recommended contents of the presentation.
Although the Final Oral Defence and the Proposal Defence have similar presentation
formats, students should expect that the Final Oral Defence will have a greater level of
rigor.

THE FINAL ORAL DEFENCE STAGE:
Process for Dissertations
1. When the PL has approved the dissertation, he/she sends it to an External Examiner.

2. After the External Examiner has reviewed the dissertation, the PL, in consultation
with the Dean, sets a date for the Final Oral Defence.

3. The PL informs the members of the Final Oral Defence Panel that the Oral Defence
date has been set and assures the availability of members. The Final Oral Defence
Panel consists of the:
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e Dean, Chair

e Programme Leader

o Designated Faculty of the Programme

e Primary Adviser

e Two Secondary Advisers, one of whom is the methodologist
e External Examiner

4. Attendance at the Final Oral Defence is open to the public. Those present may
participate in directing questions to the student on the topic of his/her research, when
invited by the Dean. The audience will not be provided with a copy of the student’s

paper.

5. Atthe conclusion of the Defence and following an executive session of the Panel, the
student is informed how the Defence was scored:

e Very Good - No corrections necessary.

e Good- Minor corrections necessary; student may take up to one (1) month to
make the corrections and submit the revised thesis/dissertation to the Primary
Adviser.

o Fair- Major corrections necessary; student may take up to two (2) months to
make the corrections and submit the revised thesis/dissertation to the Primary
Adviser.

¢ Fail- Thesis/Dissertation is not accepted; the student must begin the process
afresh.

6. If revisions are necessary, the recording secretary/PL communicates them to the
student and Primary Adviser, along with the time frame given to finish revisions. This
will be provided in writing and the student is expected to be diligent in making
revisions. These revisions are done in consultation with the Primary Adviser, who
then confirms that all the revisions are satisfactory and submits the Final Correction
Confirmation Form, along with the thesis/dissertation to the PL.
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Format of the Final Oral Defence

The Final Oral Defence for a dissertation is generally no longer than two and a half
hours and no shorter than two hours in duration. The researcher has 30 minutes to present
a PowerPoint presentation. Following the presentation, the Panel uses approximately 60
minutes for cross examination. Students and supporters may attend the Defence—it is
open to the public—and they may participate in directing questions to the student on the
topic of his/her research, when invited by the Chair. The audience will not be provided
with a copy of the student’s paper. Table 2 (below) presents sample contents of the
dissertation presentation. Additionally, referring back to Table 1 will refresh
presentation and formatting tips. The Final Oral Defence of a dissertation is considered
to be the most rigorous among all levels of the exercise.

Table 2.Sample Distribution of Slides for Final Oral Defence

Presentation Content

Title Slide

Introduction

Problem Statement
Research Questions/
Objectives/ Hypotheses
Conceptual/Theoretical
Framework
Methodology

Results

Proposed Product
Development/ Program
Development

Proposed Model/
Framework/Concept/Theory
Conclusion
Question/Answer Time

Number
of Slides

1

2-3

1-2

1-2
1

2-5

3-7

1-3

1-2

2-3

Note

Include Title of the Research Proposal,
Program of Study, Name of the Student and
the date.

Brief background of the Study

Project the diagram/figure

Include the research design, population,
sample size determination and sampling
method, instruments and method of data
analyses. (2-5slides)

Use Tables/Figures to present your results

For projects

For dissertations (Project the Model/

Framework/Concept/Theory)
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On-line Conferencing Final Oral
Defence Tips

The skills gained during the Proposal Defence were preparatory for the Final Oral
Defence. These tips were given previously in the Handbook at the proposal stage;
however, they are valid for this Defence also:

o Speak slowly and clearly.
e Make sure each person present can hear everyone else.

¢ Allow for a transmission time lag. This can be up to two seconds over very long
distances.

e Always assume it is going to take longer than planned to set up the video link.
You can interface prior to the Defence time with the AUA IT team to make sure
your equipment is working properly and you know how to optimize the connection
on your end.

e Ensure there is no background noise, especially from nearby traffic, air-
conditioning systems and other people in the area.

e Make sure that the latest approved copy of your thesis/dissertation has been sent
to your Programme Leader before the Defence in order for your Panel to review
your paper in advance of the Defence. Inform your Adviser(s) of any substantive
changes and get his/her approval.

¢ Remain positive and confident. Even people who are not anxious about speaking
in public can get nervous when their research is being examined. These is
natural—take a deep breath and enjoy the process.

Forms for the Writing and Final Oral
Defence Stage

Below is a listing of the Samples, Forms and Grading Assessments that are used in
the Writing and Final Oral Defence Stage. All of these documents are located in Chapter
9 of this SPS Research Handbook for your convenience.

Some of these documents are generated by the student, some by the Programme
Leaders, Advisers or Examiners. Review each form so that you are familiar with them
and how they are used. In the case of Grading/Assessment/Evaluation forms, these are
provided so that you know what is expected of your work, which will help you in
planning, writing and defending your project/thesis/dissertation.

Give attention to the title of the documents so that you know whether they are used
for a project or a thesis or a dissertation.
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Forms

v

I N N N N T N N N N N N NN

Preliminary Pages for the Written Project/Thesis/Dissertation

Chapters 1-3 (Chapters 1-3 are also found in the Proposal Stage)
Chapters 4-5

Figures/Tables

References

Appendix

Curriculum Vitae

Final Thesis Oral Defence Examination Form

Final Dissertation Oral Defence Examination Form

External Examiner Evaluation Form for Final Oral Thesis Defence
External Examiner Evaluation Form for Final Oral Defence—Comp Sci
External Examiner Evaluation Form for Final Oral Dissertation Defence
Final Oral Thesis Defence Assessment Form

Final Oral Dissertation Defence Assessment Form

Final Oral Defence Correction Confirmation Form

56



CHAPTER 4

Submission of the
Project/Thesis/Dissertation






SUBMISSION OF THE RESEARCH PROJECT

Since projects are not required to have a Final Oral Defence, the paper is now ready

to be submitted. The Research Protocol outlines the process for project submission after
it has been approved by both Advisers and the Primary Adviser has submitted it to the
PL.

FINAL SUBMISSION: Process for Projects

At this point, the PL requests grades from the project from both Advisers. A copy of

the Grade Report for Advisers is shown in the Forms section so that students know what
the Adviser grades are based on.

1.

The PL gives the Project a final check, directs the student to fill the Printing and
Binding Form, and completes the Printing and Binding Form by adding the grades.
The PL submits the final grade to the Dean on the SPS Grade Sheet, as per protocol.

. The PL sends the Project, along with the Printing and Binding Form, to the Research

Office for review and editing. During this process, editorial changes may be made to
the paper to improve the grammar and flow of the paper or to correct errors in style
and format. Students and Advisers should not submit Projects directly to the Research
Office—submission is made only by the PL.

If substantive concerns are observed that may compromise academic quality, such as
plagiarism or ethics, the Research Director sends the Project back to the PL with a
written explanation of concerns. The PL can give input and/or return the Project to
the student for corrections. If the Editor finds significant errors in style and
formatting, the Editor will return the Project to the PL, who returns the paper to the
student for corrections. The PL also copies the Advisers so they can provide
assistance to the student, if necessary.

The student sends the corrected paper back to the PL, who reviews the corrections
made by the student for accuracy. The PL then returns the paper to the
Editor/Research Director so that it continues through the process.

. After the Research Office approves the Project, it is sent to the PL who then sends it

to the Dean’s Office for final approval signature. The following signature lines are
authorized for the Approval Page:

e Primary Adviser

e Secondary Adviser
e Programme Leader
e Head of Department

e Dean
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6. When the Dean has given final approval, and signed the Approval Page, the Project
is sent from the Dean’s office for printing and binding. The Dean’s office submits the
student’s name to the Registrar’s Office, where eligibility for graduation is
determined.

7. When the printing and binding are completed, one (1) copy of the Project is delivered
to the Judith Thomas Library for display in the collection.

SUBMISSION OF THE RESEARCH
THESIS/DISSERTATION

After the post-Defence requirements are met, the PL requests grades for the
thesis/dissertation from both Advisers and calculates them with the Final Oral Defence
grade to produce a weighted final grade. Copies of the Grade Form for Advisers are
shown in the Form section so that students know how these grades are derived.

The Research Protocol outlines the process for thesis/dissertation submission after
the paper has been approved by both Advisers. The Primary Adviser submits the
approved thesis/dissertation to the PL, who manages it through the final submission
processes, as shown below.

FINAL SUBMISSION: Process for Theses/Dissertations

1. The PL gives the Thesis/Dissertation a final check, directs the student to fill the
Printing and Binding Form, and then completes the Printing and Binding Form by
adding the grades. The PL submits the final grade to the Dean on the SPS Grade
Sheet, as per protocol.

2. The PL sends the Thesis/Dissertation along with the Printing and Binding Form, to
the Research Office for review and editing. During this process, editorial changes
may be made to the paper to improve the grammar and flow or to correct errors in
style and format.

3. Ifthere are substantive concerns about academic quality, such as plagiarism or ethics,
the Research Director will direct the Thesis/Dissertation back to the PL with a written
explanation of concerns. The PL can give input and/or return the paper to the student
for corrections. If the Editor finds significant errors in style and formatting, the Editor
will return the paper to the PL to be sent to the student for corrections. The student
sends the corrected paper back to the PL, who reviews the corrections made by the
student for accuracy. The PL then returns the paper to the Editor/Research Director
so that it continues through the process.

4. After the Research Office approves the Thesis/Dissertation it is sent to the PL who
then sends it to the Dean for final approval and signature. The following signature
lines are authorized for the Approval Page:
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Thesis Approval Page

v' Primary Adviser

v’ Secondary Adviser(s)
v’ External Examiner
v Programme Leader
v" Head of Department
v Dean

Dissertation Approval Page

v Primary Adviser

v Both Secondary Advisers
v’ External Examiner

v Programme Leader

v Head of Department

v" Dean

. When the Dean has given final approval, and signed the Approval Page, the
Thesis/Dissertation is sent from the Dean’s office for printing and binding. The
Dean’s office submits the student’s name to the Registrar’s Office, where eligibility
for graduation is determined.

. When printing and binding are completed, one (1) copy of the Thesis/Dissertation is
delivered to the Judith Thomas Library for display in the collection.
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PRE-SUBMISSION CHECKLIST

Use this Checklist to make sure your project/thesis/dissertation meets AUA format
and style standards BEFORE you turn it in. Do not assume that the AUA Editor will
correct these items—the job of the Editor is to check that you have done them correctly.
If there are excessive errors in your paper or it does not follow AUA style and
formatting, your paper will be returned to you for corrections. If you hire an external
editor, send him/her this Checklist so they are familiar with AUA format and style.

MISCELLANEOUS FORMAT ITEMS

Document is in ONE file, and preliminary pages are properly numbered.

Page numbers are in the same font and size as the rest of the text.

Table of Contents is formatted with tabs and dot leaders, not spaces and full stops.
Table of Contents entries are title case and page numbering corresponds to the
actual titles.

Round numbers or numbers below 10 are written out in words.

Dashes are formed by two hyphens—they have no space before or after them.

SPACING

Preliminary pages have headers at 2” (5 cm) and follow the format illustrated in
this Handbook.

Document is left-justified, and double-spaced, with no extra space between
paragraphs.

Single spacing may be used in tables.

One blank line is used between chapter number/title, two blank lines between
chapter title/text.

Two blank lines before and one blank line after subheadings within the text.

TABLES/FIGURES

Tables are readable, consistent in format, and have no vertical lines and few
horizontal lines.

Tables/figures all have an introduction and are mentioned by name/number before
appearing in text.

If tables/figures must be continued on the next page, format is consistent for both.
Tables/figures are numbered consecutively (but separately) throughout the
document.

Table numbers and titles are typed above the table, figure numbers and titles,
below.
Three blank lines before and after tables/figures inserted within the text.
All data in a figure will be visible when printed in black and white.
If a table/figure is taken from another source, the complete source is cited.
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HEADINGS and SUBHEADINGS

Headings and subheadings are properly chosen and formatted.

No heading has only a single subheading under it.

Capitalization of headings follows AUA style and is consistent throughout the
document.

Spacing above and below headings is consistent and correct (2 blank lines above,
1below).

No heading appears without at least two lines of text below it at the bottom of a

page.

REFERENCES

The Reference list is placed after the last chapter of your paper, followed by the
Appendixes, then your CV.

Every citation in the paper is listed in the Reference list.

Each reference follows APA style/format.

APPENDIX(ES)

Each item in Appendix must be in English; if there is another language, place the
document with the other language first, followed by the English translation.

All pages should be clear so they can be read and correctly placed on the page.

If you show statistical tables from SPSS (or other software), they should be correctly
formatted so that all data is clearly shown; as far as possible, try to keep tables
together on the page.
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Forms for the Submission Stage

Below is a listing of the Samples, Forms and Grading Assessments that are used in
the Submission Stage. All of these documents are located in Chapter 9 of this SPS
Research Handbook for your convenience.

Some of these documents are generated by the student, some by the Programme
Leaders, Advisers or Examiners. Review each form so that you are familiar with it and
how it is used. In the case of Grading/Assessment/Evaluation forms, these are provided
so that you know what is expected of your work, which will help you in planning,
writing and defending your project/thesis/dissertation.

Give attention to the title of the documents so that you know whether it is used for a
project or a thesis or a dissertation.

Forms
v" Printing and Binding Form

v" Grade Form for Advisers of SPS Students
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CHAPTER 5

Professional Writing Standards
AND
SPS Style and Formatting






Professional Academic Writing Standards

It is of primary importance that research writing be precise, clear, as succinct as
possible and reflective that the research undertaken was done so in a professional and
scholarly manner. Some guidance is here provided that applies for good writing of
projects/theses/dissertations.

Flow

Papers should follow a clear and logical outline. To make this happen, multiple drafts
of the paper must be written so that writing can be refined and progress to improvement.
Sentence construction should be clear and relate to each other as the topic is built.

Paragraphs

Paragraphs form the basis of a paper and are composed of sentences that support the
topic. A new paragraph begins when the writer transitions to a new thought. Paragraphs
are indented .5” or 1.27 cm. Paragraphs begin with a well-constructed introductory
statement and generally have at least three sentences.

Headings
Headings are an effective way to introduce new aspects of the chapter topic and keep
the interest of the reader. If subheadings are used, there must be at least two subheadings.

Writing Style

Clarity, Directness, and Simplicity of Expression. Eliminate jargon and wordiness.
Make the paper clearly understandable to the reader. Be as direct as possible—state
specifically what you mean, and do not leave ideas poorly explained. Readers may be
of different careers, churches, and ethnicities. They may be from different locations and
different cultures, with diverse perspectives. Therefore, when writing, make a rigorous
effort not to be narrow and sectarian. Many readers may not understand religious
jargon—explain -what phrases mean at the first use.

Avoidance of Emotional Words to Persuade. Power words attempt to convince by
force, rather than reason. Words like wonderful, evil, solution, or exciting push your
reader to accept your argument based on passion, rather than evidence. Research seeks
to understand, not so much to convince. Restraint is appropriate. Also, restrain the
assessment of the results of your study—it is difficult to change the thoughts and actions
of people based on a one week or one month experimental study or seminar.
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Correct Grammar

Take care that verb tenses correctly match the subject of the sentence. Additionally,
pronouns must be used correctly, along with the use of singular and plural words.
Researchers typically use active voice when referring to themselves. If English is not
the student’s mother tongue, it may be advisable to seek an external editor to assist with
grammar and construction.

Inclusive Language

Avoid discriminatory language that indicates prejudice against persons on the basis
of gender, sexual orientation, racial or ethnic group, disability, or age. Statements like
the woman judge, the black flight attendant, or the chairman are better rendered as the
judge, the flight attendant, or the chair. Also, avoid using words that are negative, such
as the victim of HIV, or suffers from heart disease. Instead, simply use: He has HIV;
she was diagnosed with heart disease.

Avoiding Bias

Bias consists of drawing conclusions without proper evidence. It can be manifested
in many ways in research: by failure to select the sample carefully, failure to seek
opposing opinions on a topic, privileged treatment of certain sources, or by stating
conclusions the research believes to be true, but is not supported by the data of his/her
research. As much as possible, bias should be intentionally minimized in research and
writing. When operating from personal bias, the researcher should acknowledge the bias
openly and outline the measures taken to control or mitigate the bias.

Referring to Yourself

To avoid confusion or ambiguity, refer to yourself in the first person— “I instructed
the students,” or “my calculations showed ...” To avoid saying “I” often, recast the
sentence to say “students were instructed.” Writing “the researcher” or “this researcher”
is generally no longer appropriate. Generally, the principle is to try to minimize
references to yourself and keep the emphasis on the research.

Reference of Gender

It is permissible to choose to use one gender generically throughout the paper.
However, it is preferable to alternate reference to gender in order to be inclusive or to
designate he/she. APA style (7" edition) allows the use of “they” as an acceptable
gender-neutral substitute for he or she.

Assistance with Spelling and Grammar

Papers that are submitted for Proposal Defence, Final Oral Defence and final review
and editing must be as free from spelling and grammatical errors as possible. Students
are wise to take advantage of the spelling and grammar checker in Word or a software
program like Grammarly.com, which provides suggestions to improve writing.
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Word flags potential errors by displaying jagged underlines of the word, phrase or
sentence:
¢ Red underline: means the word may be misspelled;
e Green underline: means there may be an error in grammar;
o Blue underline: means there may be an error in formatting or an inconsistency;

Word is not ALWAYS correct when there is an underline, but check each underline
before submitting the paper to the Adviser or Programme Leader. The grammar checker
can be wrong, but do not ignore it. Papers with a lot of underlining may be returned for
corrections by the Adviser, Programme Leader or the Research Office.

Crediting Sources

Finding Quality Sources

Postgraduate students carefully assess all sources they use in their research. Just
because a journal published an article and it appears scholarly does not mean that it is.
This is particularly true when it comes from the Internet. Judge all research sources
carefully with the following in mind:

1. Try to use sources that were written five to seven (5-7) years ago. The exception
is historical sources and theological references.

Choose refereed sources, over anecdotal or personal sources.

Prefer primary studies to secondary ones.

Choose recent journals over books; they are newer, and contain primary data.
Look for data included in text that support the conclusions drawn.

Choose academic sources, rather than newspapers, magazines, etc.

SRCLIE N

Introducing Quotations

Quotes should be introduced carefully so that the reader knows why the quote was
chosen. Beginning a quote by saying “Hudson says that ...” does not add any
information. The quotation marks and the reference already communicate this. Use this
space to say something important that gives more information. “Comparing students
from wealthy communities to those from poor neighborhoods, Hudson concludes
that...” This gives more information about the source—in this case, that the conclusion
is based on a comparison of two groups of people. Words such as says, comments,
mentions, and writes do not really say much about the relationship of the quoted material
to the ideas you are discussing. When you quote, be sure to add some value to what is
already there.
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Discussing Quotations

Never let another author get the last word (or the only word) about your topic. You
are the author. Tell us what you saw in this quotation, why it is meaningful and relevant
to your topic. Quoting is not an exercise in cutting and pasting. Discuss the quotation,
compare and contrast it with other sources. At all times, make clear to your reader who
is speaking. If you do not give a reference, it is presumed that you are making the
statement. If the idea comes from somewhere else, be quick to give credit. Do not quote
more than necessary; trim the quote to the part that really applies to your study (use
ellipsis marks if you leave out information from the middle of the quote).

Dealing with Secondary Sources

Sometimes, as you read one source, you find that the author quotes another source
which you find interesting. This is a secondary source. Generally, do not quote
secondary sources—try to access the original source and quote it instead. It is never
appropriate to use the secondary source as a primary source—distinguish clearly
whether you are quoting the primary or secondary author. Using too many secondary
sources is also frowned upon. Finding the original sources shows you have done your
research carefully.

Citing Abstracts

If you find an abstract but cannot access the complete article, you must cite it in your
bibliography or reference list as an abstract, not as if you actually read the article. To do
otherwise is considered deceptive and unethical.

Mechanics of Writing

Period. Use a period at the end of a complete sentence. Use it to separate parts of a
bibliographic entry, and after all but the most common abbreviations.

Comma. Use commas between elements (including before words such as and and
or) in a series of three or more items. Do not use commas for seriation within a
paragraph or sentence if there are commas within the items; rather, use semicolons (e.g.,
The respondents were (a) mothers, 20-30 years old; (b) 3rd-grade students; and (c)
teachers with 5 years’ experience).

Colon. Use the colon after a clause to introduce a series of items only if the clause
is a grammatically complete sentence (e.g., The following are ways to treat insomnia:
(a) think about short-term HRT, (b) consider an alternative, (c) wick away the problem,
and (d) chill out). Do not use a colon after an introductory phrase that is not a complete
sentence, or after a verb to introduce a series of items (e.g., The respondents were (a)
mothers, (b) 3rd-grade students, and teachers with 5 years’ teaching experience).
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Parentheses. Use parentheses (not square brackets) if you wish to explain something
that does not fit with the grammar of your sentence. Do not use parentheses back to
back; rather, use a semicolon to separate the statements, and enclose them in a single
set of parentheses.

Hyphen (-). Hyphenate a compound word with a participle when it is before the
word it modifies (e.g., the t-test results, decision-making policies, up-to-date
technology, middle-class houses, 4th-year students). None of these are hyphenated if
they occur after the noun (e.g., the results from the t test, policies about decision making,
the technology was up to date, houses of middle class employees, students in the 4th
year). Do not use a hyphen if a compound adjective cannot be misread or its meaning is
established (e.g., grade point average). Self-compounds are always hyphenated
regardless of whether they are used as an adjective or a noun (e.g., self-explanatory,
self-study, self-confidence).

Dash (—). A dash usually shows an interruption of the flow of thought (e.g.,
Beethoven’s music—unlike that of Mozart—uses emphatic rhymes). If you are typing
in Word, the dash will appear automatically if you type two hyphens, then continue

typing.

Ellipsis points. Three dots indicate omitted words in direct quotations within a
sentence. Leave spaces before and after the dots. For omitted words between sentences
or paragraphs, use four dots; the first serves as the period for the first sentence (so it has
no space before it). Do not use ellipses at the beginning or end of a quote, but when
material is removed from the middle.

Single quotation marks. Use single quotes to enclose text that was enclosed in
double quotes in someone else’s work. This is a secondary source, and should be used
sparingly. The source of the material in single quotes should not be put in your reference
list. In some fields, a specific word may be set off in single quotation marks, but this is
not common.

Double quotation marks. Use double quotation marks to show every place someone
else’s words are quoted directly, unless it is a block quote, in which case the quotes are
not necessary.

Capitalization. Capitalize proper nouns (Seventh-day Adventist is commonly

misspelled; this is the correct spelling). Avoid incorrect and inconsistent capitalization
throughout the paper.
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Titles. Use title case for subheadings (Levels 1 and 2). For tables, the table number
appears on its own line, in plain text, followed by the table title on the following line,
in italics and title case. In case of figures, the figure number appears below the image,
in italics and followed by a period. Figure caption on the same line, in plain text and
followed by a period. Use full caps for chapter titles. In titles (but not in the reference
list), when a capitalized word has a hyphen, capitalize both words (exceptions can be
made if it makes good sense); in titles, also capitalize the first word after a colon or
dash.

Title case. Title case capitalizes all nouns, pronouns, verbs, adjectives, adverbs, and
other words of four letters or more, except short prepositions, articles, or conjunctions.

Sentence case. Sentence case uses lower case for all words, except the first word
and proper nouns.

Academic references. Capitalize names of university departments if they refer to a
specific department within a specific university and academic courses if they refer to a
specific course; e.g., Department of Public Health, or Financial Management; but do
not capitalize generic titles: any department wishing to participate, or curriculum and
instruction courses.

Tests. Capitalize exact, complete titles of tests; e.g., Kolmogorov-Smirnov Test; the
words test or scale are not capitalized if they refer to subscales of tests; e.g., Minnesota
Multiphasic Personality Inventory Depression scale.

Reference list. Use sentence cases in reference lists, i.e., capitalize the first word of
titles of books and articles, proper nouns, and the first word after a colon or dash. Titles
of periodicals are in title case.

Tables/figures. Use sentence case for figure titles and headings or text within tables
and figures. Use title case for table titles.

Numbers. Write out small numbers. The general rule is to use figures to express
numbers 10 and above. Use words to express numbers smaller than these.

Figures. Use figures for exact numbers, such as time (8:15), dates (May 14), ages
(2-year- olds), weights or measures (2.5 kilos, 5 cm), mathematical/statistical functions
(divided by 6, 5 times as many), and items in a numbered series (Level 2, Grade 5). Also
use numerals in the abstract of a paper, in tables, and in parentheses. For decades or
other plurals, the correct form does not require an apostrophe (1970s).
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Statistics. Statistics can be presented in text, in tables, and in figures. A general rule
is that if you have three or fewer numbers, use a sentence; if you have from 4 to 20
numbers, use a table; and if you have more than 20 numbers, consider using a graph or
figure rather than a table.

¢ Do not give a reference or a formula for statistics in common use

¢ In tables, use a capital, italicized N to specify the number of members in a total
sample; use lowercase, italicized n to specify the number of members in a limited
portion of the total sample. Do not use the statistical symbol of the term in the
text; use the spelled-out form.

o Use lowercase Greek letters (not italicized) to represent population statistics; use
italicized Latin to express sample statistics.

e Use the percent symbol (%) only when preceded by a number or in tables.

Abbreviations/acronyms. Acronyms should be used sparingly. Do not switch
between an abbreviation and the spelled-out form.

Introducing an abbreviation. Do not introduce an abbreviation if it will not be used
at least three times in the paper. The first time an abbreviation is used, explain it in the
text with the acronym/abbreviation in parentheses, and be sure it is in the list of
abbreviations at the beginning of the paper if there is one. Thereafter, use the
abbreviation, unless it makes better sense to spell out the word, such as at the beginning
of a sentence.
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SPS STYLE AND FORMATTING GUIDELINES

The format and style of SPS project/thesis/dissertation proposals and the final version
of the paper must conform with the latest edition of the Manual of the American
Psychological Association (APA). The SPS Research Handbook is based on the 7"
edition of the APA Manual (2020). In matters of format not specified in the SPS
Research Handbook, follow the specifications of APA.

There are a number of internet sites that present the APA Manual in condensed form.
If one of these sites is used, be confident that it is current and correct. One simple to use
and complete resource that SPS recommends is found at http://www.bibme.org/citation-
guide/apa/.

What follows is an abbreviated Guide to SPS Style and Format with the most
common usages for students.

1.

Margins. The margins in the text are:

Left — 1% inches

Right — 1 inch

Bottom — 1 inch

Top — 1 inch for all pages, except the first page of every chapter and all of the
preliminary pages, which have top margins of 2 inches.

Alignment. Use left-aligned margins for all text in the body of the paper.

Font Style and Size. Use Times New Roman font type, font size 12 throughout
the document, including chapter titles and headings. Table and Figure data can be
in Times New Roman, font size 10, if space is an issue, but the captions remain in
font size 12. Be sure to use a consistent size with all tables throughout the paper.

Page Numbering. Numbers are placed at the bottom center of each page, in the
same font/size as the text. Preliminary pages are numbered using lowercase
Roman numerals (e.g. iii, iv), counting from the Title Page, but showing the
number starting on the Table of Contents Page. The main text (From Chapter 1 to
the end of the project/thesis/dissertation) is numbered consecutively using Arabic
numerals (e.g., 1, 2, 3).

Line spacing. Text is double spaced, and indented 5 spaces (.5”) at the beginning
of each paragraph, with no additional space between paragraphs. Numbered (and
bulleted) lists and tables can be single spaced if it improves readability.

Levels of Heading. When a document requires the use of headings, the following
levels should be utilized, as appropriate. It is wise to create headings with Word
Styles so that they can be populated in the Table of Contents automatically. Create
Headings that conform to these levels. Levels Four and Five are rarely used.
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Level Zero—Use with Chapter titles; Centered and all capitals, no periods
Level One—Centered, bold and title case, no period

Level Two — Left aligned, bold and title case, no period

Level Three— Indented, bold and sentence case, ending with a period

Level Four — Indented, italics, bold and sentence case, ending with a period
Level Five — Indented, italics and sentence case, ending with a period

hDo o0 o

7. Widows and Orphans. The first or last line of a paragraph should not appear
alone at the top or bottom of a page—this is called a widow/orphan. Instead,
bump widows or orphans to the previous/next page so that all text appears
together. A subheading at the bottom of a page must have at least two lines
of text below it, otherwise, the subheading should begin at the top of the
next page. You may allow more than 1 inch at the bottom of a page in order
to avoid “widow” and “orphan” lines.

8. Lists and Enumerations. If there are several enumerated items within a
sentence, use a comma to separate items unless items in the list contain
commas; in that case, use semicolons. An identifying element (letter or
number) should always be on the same line as the item. While numbers or
letters are generally used in a paper for the vertical listing of items, bullets can be
used if the ranking of the items is not important. Lists and enumerations can be
double or single spaced—whichever is more readable and neat.

In-Text Citation

APA requires the use of in-text citations when you use the words or thoughts of
another person. Footnotes are not used in APA style. Any idea that is not original to
yourself should have a citation in your paper. The citation rules vary, depending on
whether you have quoted someone’s words or merely referred to their ideas.

How to Use Direct Quotations

Capitalization. Direct quotations may be part of the grammar of the sentence, or not. If
they are, the beginning of the quote is not capitalized, even though it might be in the
original work.

Smith (1985) did not describe the child's behavior, but he did state that “the entry of
the child into the strange environment caused disturbed behavior” (p. 123).

He stated, “The entry of the boy into the strange environment caused the disturbed
behavior” (Smith, 1985, p. 123), but he did not describe the behavior.
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Page number information. If you use a direct quote, you must include the page number.
The author’s name and date may appear in various positions, but the page number is
placed at the end of the quote, after the quotation marks but before the period.

The results of the experiment (Smith, 1985) showed that “the entry of the child into
the strange environment cause disturbed behavior” (p. 123).

Note: If a quote includes two or more pages, use a double p before the page number (pp.
45-46).

Block quotations. A direct quotation of 40 words or more must be formatted as a block
guotation, indented one tab position and double-spaced. Punctuation after the
introductory statement is optional—it depends on what introduction is used.

Smith (1985) stated:

After the child made some friends and identified with the adult in charge, the
disturbed behavior decreased. The time factor required for this “settling in” process
varied from child to child, depending on the age of the child, the general atmosphere
of the new environment, and the temperaments of both the child and the adult
involved. (p. 124)

Note: In block quotations (unlike in-text quotations), the final punctuation follows the
material quoted, and is followed by the reference, without any final period.

How to Paraphrase a Quotation

A paraphrase does not utilize the original grammar of the sentence and is in your own
words. The page number (or paragraph number, for electronic sources) is not required
for paraphrases. Be careful when paraphrasing not to use too many of the author’s
original words, or use it exactly as a quotation if paraphrasing is too difficult.

In his study, Smith (1985) observed that when the child entered the strange
environment, disturbed behavior resulted (p. 123).

Introducing Citations or Quotations

There are many ways to cite in text, but the ideal forms use sentence space to discuss
and analyze the quote or the citation, not to indicate who said it (the reference already
does that).

a) An alternative interpretation that Smith (1985) suggestsisto ...

b) The results of one experiment (Smith, 1985) showed that ““...” (pp. 73-75).
¢) Coffee drinking has been found to affect ... (Day, 2005, p. 280).

76



d) As Day (2005) says, “...” (this is not the best)

If you occasionally wish to discuss the author, or wish to emphasize something about
the individual, sentences like those below would be appropriate.

e) In 1985, Smith studied ...
f) Smith (1985), who is an expert in the field of nutrition, found ... (p. 74).
g) Smith (1985, chap. 5) gives a summary ...

Specific In-Text Referencing Rules

1. If information is given in the sentence, it is not repeated in the parentheses. See

example a) above.

The name and date can go with the page or earlier. See examples b) and c) above.

3. If the name is used in text, the date usually follows it. See examples f) and g)
above.

4. The period or other punctuation marks are placed after the final parenthesis or at
the end of the sentence.

5. When the author Smith and Johnson appear in the text, the word and is written
out. When the names appear in parentheses, an ampersand (&) is used (Smith &
Johnson).

6. What is inside the parentheses is NOT considered part of the grammar of the
sentence. For that reason, one cannot say “As (Smith & Johnson, 2009) suggest...
.” Rather, say “As Smith and Johnson (2009) suggest ... .”

N

Repeated References to an Author within a Paragraph

1. APA requires that the name and date reappear with each new paragraph.

2. A study or an author may be mentioned again within the same paragraph without
repeating the name, as long as it is clear to the reader which study is indicated.

3. If the name is used a second time within the paragraph, however, the year should
accompany it, for clarity.

4. If the author’s name was placed within parentheses the first time, as in examples
b) and c) above, it cannot appear as “he” or “she” thereafter, since the parentheses
are not part of your sentence.

Examples of In-Text Citation Format

The following are examples of how to use in-text citations correctly. These are the
most commonly used. For other types of citations, refer to the APA Manual.

One Author

The required information is the author’s surname and the year of the publication.
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a) An alternative interpretation (Smith, 2007) suggests that ...
b) Grisso (2009) takes the idea a bit further when she ...

Multiple Authors
Two authors. Include both authors every time you mention them.

Three to five authors. Include all authors the first time you cite them. For subsequent
citations, use the surname of the first author and “et al.”

First citation
a) One study (Smith, Johnson, & Brown, 2007) found ...

b) Smith, Johnson, and Brown (2007) found ...

Subsequent citations
¢) Another study (Smith et al., 2007) found that ...

d) Smith et al. (2007) found that ...
e) Smith and others (2007) found that ...

Six or more authors. Use the first author's surname and “et al.” the first and any
subsequent times the source is used.

Recent research (Brown et al., 2008) indicated ...

Several Works in the Same Reference

When more than one source is given in parentheses, the authors' names are listed in
alphabetical order. Note that all the studies were read by the researcher. Even if a source
lists several references, you may only list the one(s) you read—you may not simply copy
a list of references taken from someone else’s study.

Same author.
Several studies (Smith, 1977, 1982, 1983) show ...

Different authors.

Recent studies (Brown, 1999; Johnson & Smith, 2008; Morrison, 2004; Smith &
Ogleby, 2009) indicate that ...
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One Author in the Same Year
a) Smith (1984a) has pointed out that ...
b) Several studies (Brown, 2010; Smith, 2007a, 2007b) indicate that ...

No Author

When no author is listed, it may be that an organization authored the piece (see
Corporate Author, below). If there is no author listed, use the title, or at least the first
few words of it, in the author position. If it is a book, periodical, or report, italicize it. If
it is a journal article, title of a web page, or a chapter in a book, put it in quotes.

a) Current information (Education Handbook, 2007) suggests that ...
b) Recent studies in this area (“Six Studies on Learning,” 2008) seem to show that

Corporate Author

When citing government agencies, corporations, study groups or associations, use the
full name every time it is mentioned in the text (see example a, below). You may
abbreviate the name for the second and subsequent citations if the abbreviation is
familiar, if it has been explained in the text and will be used at least three (3) times (see
example b, below), or if the complete name is very long.

a) Statistics released (National Institutes of Mental Health, 1986) seem to show ...
b) A statistical analysis by the National Institutes of Mental Health (NIMH,1986) ...

In the reference list this would be spelled out as National Institutes of Mental Health.
If you have five or more abbreviations in your paper, it is appropriate to make a list of
abbreviations at the beginning. Once an abbreviation is explained, it should be used
consistently throughout the paper.
Authors with the Same Surname

If two or more references have authors with the same surname, use the initials or, if
necessary, the complete name of each author in all citations to avoid confusion.

a) K. Lee (2008) suggests that Koreans were trying a different approach ...
b) Other research (see for example J. Lee, 2007) has found ...

Personal Communication
This form is used for letters, e-mails, or conversations, with the author. Such

references do not appear in the reference list. Give the initials with the surname and the
complete date.
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L. R. Brown (personal communication, October 20, 2009) said that ...
Reprinted or Republished Works

The first date is that of the original publication and the second is the date it was
republished, reprinted, or published in the translated form. This information is especially
useful if the study is following a historical sequence.

a) Early research on Cerebral Palsy (Freud, 1933/1974), pointed out that ...
b) The aim of true education is ... (White, 1903/1952).

Electronic Media

Often no page numbers are provided with electronic sources. In that case, use
paragraph numbers (preceded by “para.” or “q”) to direct the reader to quoted material.
Give the nearest document heading, and then count the paragraphs after that heading.
Note that the web address (URL) does not go in the in-text reference. It goes in the
Reference list.

a) As Rittenhouse (2001, para. 3) aptly phrased it, “There is no need ...”
b) “It is clear from conditions today that ...” (Jacobs, 2003, Conclusion section, | 1).
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Reference List Rules

The APA Manual requires a reference list at the end of the paper that includes each
source cited in the paper. No extra sources are allowed in the reference list.

General Rules for Reference Lists

g > w D oE

References are listed in alphabetical order.

Run-over lines in references are indented by the regular default of .5”.

Entries are single spaced. Double space between entries.

When an author has several works, each entry must provide the author's name.

Several references by one author are arranged by year of publication, the earliest
first—not alphabetically by title. References by the same author with the same
publication date are arranged alphabetically by title and assigned lowercase
letters (a,b,c) immediately after the year within the parentheses.

Italics are used for titles of books/journals, they are never underlined.
No quotation marks are used for article titles in magazines/journals.

For books, give the publisher only, city and state/country of publication are not
required.

Titles of books are presented in sentence case. Proper nouns and the first word
after a colon are capitalized. For example:

From program to practice: A guide to beginning your new career

10.Journal titles are presented in title case. The title and the volume number are

italicized. An issue number (if available) follows the volume number (no space),
within parentheses (but not in italics). This is followed by the page numbers
where the article was found. For example:

Ali, W. H. (2004). Learning teams and low achievers. Social Education, 48,
60-64.

Astin, A. W. (2007). Change. Competition Journal, 19(5), 12-19.
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Author Rules
Single author entries. Single author entries precede multiple-author entries:

Alleyne, R. L. (2001).
Alleyne, R. L, & Evans, A. J. (1999).

Same authors, different year of publication. Identical author entries are arranged by
year of publication, the earliest first:

Cabading, J. R., & Wright, K. (2000).
Cabading, J. R., & Wright, K. (2001).

Different subsequent authors. These are arranged alphabetically by the surname of
the second author, or third author (if the second author is the same), and so on:

Gosling, J. R., Jerald, K., & Belfar, S. F. (2000).
Gosling, J. R., &Tevlin, D. F. (1996).

Hayward, D., Firsching, A., & Brown, J. (1999).
Hayward, D., Firsching, A., & Smigel, J. (1999).

Different authors with the same surname. Arrange alphabetically by the first initial.

Mathur, A. L., &Wallston, J. (2009).
Mathur, S. E., &Ahlers, R. J. (1998)

Referencing Electronic Media

Using resources on the Internet can be a challenge because information may often
be missing. Internet sources should provide the same information as any other reference,
if it is available, and a Uniform Resource Locator (URL) address. The retrieval date is
no longer generally required. Specific suggestions include:

1. Direct your reader as closely as possible to the information being cited—rather
than the home page or menu pages.

2. Test the URLs in your reference list before the final submission of the document
to make sure the document is still available.

3. Do not put a period after a URL.

4. Break a long URL before punctuation. Use shift + enter to move the text to a new
line.
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5. When there is a high possibility of change (personal websites, wikis, blogs, online
discussions) the retrieval date should be included.

Juke, A. (n.d.). My opinion about homework. Retrieved January 13, 2010
from http://www.myopinion.com

6. Remove the underlining and blue color from URLSs before you submit your paper.

7. Include a Digital Object Identifier (DOI) if it is given with the Internet resource.
If you include the DOI, there is no need to give a URL for online journals.

Printed Materials
One Author

Sommer, R. F. (1989). Teaching writing to adults. Jossey-Bass.
Up to Seven Authors

Bennett, N., Crawford, M., & Cartwright, M. (2003). Effective educational
leadership. Open University Press.

For more than seven authors, consult the APA Manual.
Author as Publisher

American Psychiatric Association. (1990). Diagnostic and statistical manual of
mental disorders(3™ ed.). Washington, DC: Author.

National Science Foundation. (2010). Earth sciences: Instrumentation and
facilities.Arlington, VA: Author.

Edition Other Than the First

Denis, T., White, N., & Peterfreund, S. (2005). Great traditions in ethics (11%ed.).
Wadsworth/Thomson Learning.

Edited Book (Editor as Author)

Roth, J. (Ed.). (1995). International encyclopedia of ethics. Fitzroy Dearborn.
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Book in a Foreign Language
Kleinert, U., &Kiihn, R. (2011). Und Sie zogenaus in Ein wistes Land: Auf den
Spuren der BibelDurchden Sinai. [And they went out into a barren land: On the trail
of the Bible through the Sinai]. Wissenverbindet.

Article in a Magazine

Adams, W. (2010, May 10). Norway builds the world’s most humane prison. Time,
175, 78.

Article in a Newspaper

Gardiner, B. (2010, April 15). Emphasis on ethics. The Wall Street Journal,
p. 9.

Article in a Journal

Knatterud, M. E. (1991). Writing with the patient in mind: Don’t add insult to injury.
American Medical Writers Association Journal, 6, 10-17.

Electronic Sources

In APA style (7" edition), the words “Retrieved from” or “Accessed on” are no
longer included in the citation.

Entire Book Online

Boud, D., &Feletti, G. (Eds.). (1999). The challenge of problem-based learning (2nd
ed.). http://books.google.com/books

Avrticle with DOI
Articles retrieved from an electronic database are now cited exactly as the print
version unless the article is particularly difficult to find. No need to include date
retrieved or the database. The DOI is included, when present, however, whether you
read the print or the electronic version.

Devlin, J. T. & Poldrack, R. A. (2007). In praise of tedious anatomy. Neurolmage,
37, 1033-1041. DOI:10.1016/j.neuroimage.2006.09.055
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Internet Article or Website (Without DOI)

Lumsden, L. (1994). Student motivation to learn.
http://chiron.valdosta.edu/whuitt/files/stdtmotv.html

Article in an Internet-Only Journal

Salend, S. J. (2004). Fostering inclusive values in children: What families can do.
Teaching Exceptional Children, 37(1), 64-69.
http://journals.sped.org/index.action=TEC_toc&ID=55

Newspaper Article (Online)

Kershaw, A. (2010, May 05). Students hit by lecturers’ strike. The Independent.
http://www.independent.co.uk

Website of Organization or Governmental Agency

British Educational Communications and Technology Agency. (2010). Assistive
technology and the Home Access programme.
http://schools.becta.org.uk/index.php?section=oe&catcode=ss_es
_hom_02&rid=17557

U.S. Copyright Office. (1981). Circular R1: Copyright basics (Publication No. 341-
279/106). Washington, DC: Government Printing Office.

Article from Wikipedia
School violence. (2010, May 13). In Wikipedia, the free encyclopedia. Retrieved
May 20, 2010, from http://en.wikipedia.org/wiki
/School_violence

Thesis Retrieved Online
Havens, L. (2009). Behavioral and socioeconomic differences among users of the
internet public library from North Carolina. (Master’s thesis).

http://www.openthesis.org/documents/Behavioral-Socioeconomic-Differences-
among-Users-594471.html
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Unpublished Material

Unpublished Paper
Skinner, E., & Belmont, M. (1991). A longitudinal study of motivation in school:
Reciprocal effects of teacher behavior and student engagement. Unpublished
manuscript, University of Rochester, NY, USA.

Thesis/Dissertation
Akpa, V.0O. (2006). Factors that motivate employees to work at Northern Luzon

Adventist College (NLAC), Philippines: An analysis (Unpublished master’s thesis).
Adventist International Institute of Advanced Studies, Silang, Philippines.

Missing Information
No Date

Bligh, B. (n.d.). Cherish the earth. Macmillan.
No Author

Handbook of research. (1998). College Board Publications.

Not all of the APA style rules are given in this handbook. Students are encouraged
to consult the APA Publication Manual, 7" edition, or in online materials to find other
references rules, as needed. Three helpful online sites are
APA

http://www.apastyle.org/index.aspx
Active as of 11/26/2019

The Owl at Purdue: Online Writing Lab
http://owl.english.purdue.edu/owl/section/2/10/
Active as of 11/26/2019

APA Citation Guide in BibMe

http://www.bibme.org/citation-guide/apa/
Active as of 11/26/2019
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CHAPTER 6

Computer Formatting Tips






Computer Formatting Tips

Even when a student is familiar with wusing a computer, writing a
project/thesis/dissertation will likely take more time to finish. The style and format
required by AUA may mean new computer skills need to be learned—and there are tips
to make it easier and quicker to format the paper correctly. This chapter was added to
help save your time and energy, but will not replace a basic knowledge of word
processing computer usage. Since most students at AUA use Microsoft Word, many
specific tips will be given for that software. If you use a Mac, it is possible some of the
explanations will not work or be done in a different way on Mac. Many, however, can
be used with any word processor.

A writing template for projects/theses/dissertations is available from the AUA Editor
or Research Director. This template is correctly formatted and uses APA/SPS style so
that errors are eliminated when used properly.

One major tip: Learn to use the help screens in Microsoft Word when you run into
problems. It is also smart to use Google to get help when you cannot figure out what to
do. There are many free online tutorials and YouTube videos, which are invaluable, on
a variety of topics to teach computer skills. Give Wiki How a try for stepwise
instructions in computer usages for style and formatting.

General Instructions
Spacing vs. Tabs

Many people try to use spaces to format lists, to align information inside tables, or
for parallel columns. A general rule in electronic documents is to avoid using spaces
for aligning information at all times. Use tabs. If there is no tab set in the position you
desire, it can easily be adjusted on the ruler bar, or through the menu system (Tabs are
under Paragraph, at the bottom left). Inside tables, use Shift + Tab to achieve the same
result.

Many researchers also find it wiser to indent paragraphs using a tab (set at .5” or
1.25 cm) rather than using the automatic paragraph indent. Automatic indentation can
cause problems with centered headings (they end up not really centered because of the
additional tab).
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Page Setup

Page layout is easiest when the correct page layout is set up before typing begins. If
you are using Word, go to Page Layout>Page Setup. Set the paper size to A4, and set
the margins at 1.5” (3.75 cm) for the left and 1” (2.5 cm) for the other three (the bottom
one is often better at .8” (2 cm) in order to achieve text that comes 1” (2.5 cm) from the
bottom of the page). Click the marker to the right of Page Setup and under Layout in
the resulting dialog box, set the header and footer to .5” (1.25 cm). Also go to Paragraph
and under Indents and Spacing > Spacing Before and after Paragraph, choose 0 pt
before and after; under Line Spacing, set the line spacing to double space (2.0). Then
choose Set as Default.

Consistency

Human beings are not by nature as consistent as is necessary for computer work. All
headings need to be used in the same way in every chapter. Spacing, margins, fonts,
etc., need to be consistent throughout the entire document. Research does not leave
room for much creativity in the way it is displayed. There is only one font, and
generally, only one font size. Spacing before and after headings, must be exactly the
same throughout the document.

The easiest way to achieve this kind of consistency involves two steps.

1. Try to take note of the basic pattern to follow while you are writing the document,
and follow it as well as you can. Write down the pattern so you can refer to it if
you forget.

2. Once a major section of your document is completed, go over it to check for
consistency. This involves scanning the electronic document for one specific
concern at a time. Check heading levels and spacing. Then look for margins and
page numbering. Check that all indents are the same, and that all numbered lists
match. Work with Table titles, spacing, and contents.

Large Documents

Computers have many tools for working with a large document that are worth
knowing about. Moving about in a document can be greatly facilitated by the following:
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Effect Command

Go to the last page of the document Ctrl + end
Go to the first page of the document Ctrl + home
Go to the beginning/end of the line Home/end
Go to a specific part of the document Ctrl+G
Find a specific word/phrase in the document Ctrl + F
Highlight entire document Ctrl + A
Find and replace words in a document Ctrl+H

Quick Formatting

Keyboard shortcuts tend to be much faster than mouse/menu combinations,
so learning some of them can save you a lot of time. Commonly used shortcuts
for formatting include:

Effect Command

Center Ctrl+ E

Left/right justify Ctrl + L/R
Bold/italics/underline Ctrl + B/I/U
Single/double line spacing Ctrl + 1/Ctrl + 2
Undo Ctrl+z

Redo Ctrl+Y
Copy/cut/paste Ctrl + C/XIV

New page Ctrl + Enter

Adjust spacing (table lines, tabs) more finely Alt + mouse button
than a whole space at a time on the item to adjust

Tips for Specific Problem Areas
Reference List

The Reference List uses the same technique as a numbered list. DO NOT use spaces
or “enter” and then a tab to create the look where the first line sticks out further than the
rest. Type many entries without formatting them, and then highlight them and format
them at once (it is faster). Click on Paragraph>Special>Hanging and make sure it is
set to .57 (1.25 cm).
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Find and Replace

If you find an error you have made consistently throughout your document, and you
wish to find each one and fix it, you can use the computer to help you search for all
instances of something and fix it. On the Home menu, choose Find (on the top right-
hand corner of the screen). On the left of your screen in the Navigation Pane that pops
up, type what you want the computer to search for, and click on the magnifying glass,
and it will find it for you. If you wish for it to replace one text with another text, rather
than Find, choose Replace. This gives you the option of saying what you want to find,
and what to replace it with. You can do this automatically, or manually, where you
check each instance to be sure it is correct.

Formatting URLs
There are three common ways you will frequently need to format URLSs.

1. If you paste the URL into your document, make sure that it is the SAME FONT
as the rest of your text. If not, highlight it and change the font.

2. If the URL needs to break somewhere in the middle, to not leave a large blank
space on the page, find an appropriate place for the break, BEFORE some
punctuation mark in the URL. The new line of a divided URL should begin with
punctuation. Once you have identified the place you wish to divide the URL, put
your cursor on it, and type Shift + Enter (at the same time). Enter tells the
computer to make a new line; Shift tells it NOT to make a new paragraph. Do
NOT simply put a space in the middle of the URL, as this will cause the URL to
no longer function if you are trying to find the website.

3. The URLs in your paper should have the hyperlinks removed. The easiest way to
do this is to place your cursor at the end of the URL and to hit Backspace. Check
to be sure this does not remove the last letter of the URL—if you have found the
right place, it will not. It will, however, remove the blue font, and the underline.

Page Breaks

If you are finished on one page and wish to begin a new page, DO NOT simply hit
several Enters until you have pushed the cursor to the new page. This makes for many
problems later when you are formatting your text, because when you change things on
one page, it affects the next page. Instead, hit Control + Enter (at the same time). This
tells the computer to begin a new page. If you need to find this mark to delete it later,
click on the paragraph icon (f) (under the Home menu, in the Paragraph group) and it
will be visible. Then click again on the same icon to return to normal view.
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Page Numbering

It is sometimes a struggle to adjust the page numbers in one part of a document
without changing all the other page numbers in the document. The reason for this is that
Word has the underlying philosophy that if you want something changed on page 45,
you really meant to change it all the way back on page 1; therefore, it changes all the
other page numbers automatically.

If you need to change page numbering (or insert a landscape page), you must insert
a Section Break and make sure that footer is not connected to the others before you
continue. This means that if you have introductory pages with no page numbers, pages
with Roman numerals, then regular page numbers for the body text of your project, you
will need 3 sections in order to paginate this properly. This will allow you to have
several different format styles together in the same document.

To change pagination types, first, you must insert a Section Break anytime you wish
to make a formatting change. Insert the section break at the end of the page preceding
the page where you want to change numbering. Click on Page Layout>Breaks>Section
Breaks>Next Page. If the new section is different from what follows, also insert a
section break AFTER it. If you have inserted 2 breaks, you should now have 3 sections.

Before actually making the page number format change, however, you need to go to
the footer (double click on it) and “disconnect” it from other footers, so it will not affect
all the rest of the document toward the beginning, or forward to the end. To disconnect
the footer, double click on the page number to enter the footer editing space. You should
see a note at the top of the footer that says “same as previous.” Since you do NOT want
this footer to be the same as the one before, click the orange-highlighted button Link to
Previous (above, on the ribbon), and you will see that on your footer, it no longer says
“Same as Previous.” Go to the footer for the next section, and also “disconnect” it from
the section you wish to modify. Once this is done, any changes made to the numbering
or page layout in this section will not affect the other sections.

Trouble shooting.
1. When you change the page numbers in one section, it changes them in the next
section also. Either you have not inserted a section break between the two pages,

or you have not “disconnected” the footers as described above.

2. The page has the wrong number. Click on Insert>Page Number>Format Page
Number. Choose the correct number and tell it to start at that number.

3. The page number has the wrong font/size. Highlight the page number. From the

Home menu, select the correct font and size. You will have to do this for each
section, but doing it once should fix all the page numbers in that section.

93



4. The page numbers are too low on the page, or almost touching the bottom line
of text. Click on Page Layout>Page Setup>Layout and make sure the footer is
at.5” (1.25 cm). Another possible cause is that there are extra lines accidentally
entered into the footer. From the Home menu, click on the § button, then
double-click on the footer space. Examine the footer area for any hard returns
(they will appear as ) and remove them. When you are finished, click again on
thef button to return your screen to the normal view.

Viewing Section Breaks. If you wish to see what section you are in at all times,
right click on the bottom gray or blue bar in Word, and choose Section as one of the
options. This will now show you the section number at all times in the lower left corner
of the screen.

If you wish to see your section breaks, click on the paragraph icon (). You will see the
section break at the end of the text on the page. It can be deleted if need be.

Numbered Lists

To achieve nice-looking numbered lists, it is imperative to use tabs between the
numbers and the text (not spaces). This means you should type the number and the dot,
then insert a tab, then type the text. If the tab is not the right length, you can adjust it
from the ruler bar (highlight the text and drag the tab to where you want it), or you can
highlight the text and adjust the tab settings under Paragraph. When you have typed
your list, highlight the entire section, and click on Paragraph> Special>Hanging. Make
sure that the distance for the hanging indent is .5 (1.25 cm), which is the same as your
paragraph indentation. Also make sure that the distance between the numbers and the
text is the same if you have multiple lists in your document.

Numbered lists can be single- or double-spaced, depending on how they look best in
your text. You can decide.

Trouble shooting.

1. If you did NOT insert tabs between the numbers and the text, they will not line
up properly. Go back, remove the spaces, and insert a tab for each number.

2. If you ever need to adjust the space between the numbers and the text, be sure to
highlight the entire list so it stays the same.

Tables

Formatting tables is tricky, and time-consuming. Consistency here is very important.
The main computer tips are as follows:
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. Tables should not extend beyond the margins of the text. If the table is longer
than text, an option is to landscape the page.

. Remove as many lines as possible from the table, so that the table looks better
when it is printed.

3. Tables should have %2 point lines (as a border) around them, not bigger.

. Table content should NOT be double-spaced. Single-space it, then block the
ENTIRE TABLE and select Paragraph>Spacing>before and after and set it to
3 points before, and 3 after. This will allow a bit of space, but not too much. Be
consistent with all tables.

. Table content can be as small as 10-point font, but if you do this, you should be
consistent with all of the tables in the paper. The titles remain in 12-point font.

. Table text can be centered, left, or right-justified, depending on what looks best.
Usually, the left column is left-justified, and others are often centered.

. If you have decimal places that need to line up, right-justify the numbers, then
move the entire column  over toward the center.  Use
Paragraph>Indentation>Right and choose.1” or .15” or .2” (.15 cm or .37 cm
or .5 cm), depending on how far you need it to shift. You can type the number
you want.

. Do not use bold with table content, and note that the content is capitalized only
on the first letter.

. Maintain spacing before and after tables. It should be two double spaces (3 blank
lines). If this leaves only 1-2 lines of text below the table, push them to the next

page.

10.1f you need to insert spacing inside a table, don’t use spaces. Change the margin,

or use

Control + Tab if you wish to have tabs.

11.1f a table fits on a page, it should NOT be split over two pages. Move it so that it

is on the same page, but always AFTER the table was first mentioned in the text.

12.1f table content does NOT fit on the page, you have two choices: split the table

and put the rest on a second page, or create a landscape page and put the table
sideways.
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13.To create a landscape table, insert a blank page and insert section breaks before
and after it, so that it is in its own section and the footer shows that it is not linked
to the other sections (see instructions under page numbering). Then, under Page
Layout> Orientation, choose Landscape. Format your table here, and when it is
printed, turn it the same way as the other pages. You may skip the page numbering
on this page, but remember that it is counted, even if not numbered, and make
sure the numbering resumes properly on the next page.

Table of Contents

The Table of Contents contains the first 3 levels of headings exactly as they appear
in your paper, and the page numbers on which they are found. There are two basic
approaches to creating a Table of Contents: You can type the titles manually, or have
the computer do them for you automatically.

Manual method. You can set up the formatting before or after typing the entries. If
you do it afterward, be sure to highlight the entire Table of Contents text before setting
the tabs. Use a tab with dot leaders to create the line of dots. Set the tab by using
Paragraph>Tabs. Clear the other tab stops and set one at 5.6” (14 cm) with alignment
Left and Leader 2 (the one with dots). Add a second tab at 5.9” (15 cm) with alignment
Right and No Dot Leader to make the blank space before the number. At the end of
each Table of Contents entry, insert a tab, which should create the dot leader. Insert a
second tab, which should make the space and right align the page numbers. Additional
tab stops should be added at .3” (.75 c¢cm) and .6” (1.5 cm)—Ieft, no dot leader—for
indenting the second and third level headings (see below).

Sample
Heading ... 13
SecoNd LeVEl ... 65

Trouble shooting. If you have typed your Table of Contents before setting up the
tabs, here are several suggestions.

1. Before you set up your tabs, highlight the ENTIRE Table of Contents. This way,
the tabs will be set for the entire section you typed. Otherwise, you may need to
re-enter the settings multiple times.

2. From the Home tab, click on the paragraph icon (). This is a toggle on/off, and
will show you where you have spaces that may need to be erased, and other
formatting features. You can turn it off again once you have seen what you need
to.
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3. Make sure that you remove all spaces, and format with tabs. Spaces will create
an uneven line anywhere you use them.

4. Do NOT use the period with spaces between to try to make a dot leader
(...... ). It will never be evenly spaced.

Automatic method. A better way to achieve the needed consistency is to generate
the Table of Contents automatically. This takes a bit of time to set up, but if any headings
move to a different page, you can update the Table of Contents automatically.

To use the automatic method, you first must set up Styles so that the headings are
formatted properly. These headings, once set, will be used for generating the Table of
Contents. The easiest way to do this is to type a Level 1 entry heading correctly (with
the correct spacing and capitalization, bold, etc.), and then right click on Heading 1
using Home>Styles>Heading 1. Choose Update Heading 1 to Match Selection. This
means that the computer will take your heading as the new “normal” for Heading 1. Do
the same with headings for Levels 2 and 3. Once these are set correctly, you only need
to highlight any new heading, and click on the correct style—heading 1, 2, or 3—and it
will be formatted correctly, AND marked for the Table of Contents. The automatic
Table of Contents does not yield a dotted line with a small space before the numbers, as
illustrated above in the manual method. As long as the numbers are properly right
justified, this space is not required. If you use automatic Table of Contents generation,
you do not need a space between the dot leader and the page numbers.

Generating the Table of Contents. When you have marked all your headings (at
least 3 levels), create a blank page where you want your Table of Contents, and select
References>Table of Contents>Automatic Table 2. This should give you a complete
Table of Contents, but ONLY IF you have marked all the headings properly. If you have
missed some, they will be missing in the list. Check carefully.

Updating the Table of Contents. If you need to update the Table of Contents because
you changed some things or made some mistakes, simply right-click on the table, and
choose Update Field. Note that you can choose to update everything (this will destroy
any formatting you have done), or just the page numbers (this will not destroy your
formatting, but it will also not update the titles).

Trouble shooting. There are MANY things that can and will go wrong with the Table
of Contents as you format it. Microsoft Word cannot do everything. Once you have
finished generating your Table of Contents, there WILL be things you need to format
manually.

Fortunately, the generated text can be edited just like any other text you typed. Here
are some of the most common things you will need to do/problems you may experience.
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. The chapter titles are not formatted properly. Microsoft Word does not do these.
You will need to enter the word “chapter” and put in the numbers, and delete the
extra lines Word created.

. The spacing is not correct for AUA standards. The spacing required for your
Table of Contents will have to be done manually. Check where you need double-
space, single space, etc.

. The indentations for section headings are not right. Word should put in the 3
levels of headings with proper indentations for you. If not, you can do it manually.
Set tabs at appropriate distances (often .3”, .6”, and .9” or .75 c¢cm, 1.5 cm, and
2.25 cm).

.| have moved my text around (or edited the titles), but the Table of Contents
has not updated itself to match the changes. Solution: Right click on your Table
of Contents, and ask it to update. If it is text that needs to be updated, it will
destroy your formatting, and you will have to re-do it. If it is only numbering, you
can just update the numbers.

. When | update the Table of Contents, all the formatting changes | made
disappear. The solution is to update ONLY the page numbers, NOT the entire
Table of Contents.

. When | generate the Table of Contents, there are several headings that don’t
belong there. This is because those headings were marked with the style of
Heading 1, Heading 2, etc. Go to that place in your document, highlight the text,
and select Normal from the list of styles. When you regenerate the Table of
Contents (or update it), this text will no longer show.

. The title Table of Contents is not according to AUA standards. Just fix it. Type
it as it should be, making sure to put it at 2 (5 cm) with the correct space (triple
space, or 2 blank lines) after it. Make sure it is in the same font as the rest of your
document.

. There is formatting I don’t like, but I can’t see what it is actually doing. Click
on the paragraph icon (1) on the Home menu, and it will be visible, then you can
edit it.

Track Changes

Track changes is a feature of Microsoft Word that allows another reader to make
comments on your writing, or even to make changes, but keeps track of all those changes
so that the original author can see exactly what was changed. It is a handy tool that most
of you can/should use if your Advisor is at a distance and you need to send revisions
back and forth via e-mail. Later, the original author can accept or reject the advice from
the “editor” and can introduce new changes of his own, which will show up in a different
color from the editor’s work.
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Changes such as additions or deletions will be marked automatically if Track
Changes is turned on, but additional comments can be made as well. These will show
up in the margins, or in the text itself, and must be deleted by the author once they are
no longer needed. Like any other document, however, if you do not save the file once
you are done making the changes; you will lose your work.

To turn on Track Changes, go to Review>Track Changes on the menu bar in Word
and click on it. Click in the same place again, and it will turn off. Under Review, you
will see a menu bar showing the buttons needed for working with the changes—Accept,
Reject, New Comment, etc. Note the Previous/Next buttons—these are very useful for
finding comments in a large document, as they will take you from one comment or
change to the next—you do not need to search for them page by page.

Tracking sometimes shows up in the right margin, and sometimes in the text itself.
The problem with the in-text version (with strikethrough) is that it does not show the
true page breaks. The version in “balloons” makes the entire page a little smaller
(temporarily), but DOES NOT CHANGE the format, which means that your actual page
breaks will be exactly the same as what you see on screen. Unfortunately, the Word
default is NOT to put the changes in balloons, but in text. To change this, click on
Review>Show Markup>Balloons>Show Revisions in Balloons.

Notice that you can accept each change one by one, or you may read a whole
paragraph or two, highlight that section, and accept all the changes in that section by
clicking on the arrow on the right side of the Accept Change button. You may even
accept ALL the changes in the entire document, but unless you have blind faith in your
editor, this option is not recommended. Accepting all changes will NOT remove all the
comments—those must be removed one by one, as you are finished with them.

If you have removed all marks but your document still looks pushed to one
side, as if there were still comments present, choose the Accept all Changes in
Document button, and this will remove any last mark that might have remained
by accident, and the formatting will go back to normal.
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CHAPTER 7

Miscellaneous Helpful Items






Acceptable Abbreviations

African Countries are not abbreviated in APA Style
State Abbreviations for the United States

In reference lists and in-text citations, the names of the states in the United States are
always abbreviated. Below are the two-letter abbreviations for each state.

Location Abbreviation Location Abbreviation  Location Abbreviation
Alabama AL Kentucky KY North Dakota ND
Alaska AK Louisiana LA Ohio OH
Arizona AZ Maine ME Oklahoma OK
Arkansas AR Maryland MD Oregon OR
California CA Massachusetts MA Pennsylvania PA
Colorado Co Michigan Ml Rhode Island RI
Connecticut CT Minnesota MN South Carolina SC
Delaware DE Mississippi MS South Dakota SD
District of Columbia DC Missouri MO Tennessee TN
Florida FL Montana MT Texas X
Georgia GA Nebraska NE Utah uT
Hawaii HI Nevada NV Vermont VT
Idaho ID New Hampshire NH Virginia VA
Ilinois IL New Jersey NJ Washington WA
Indiana IN New Mexico NM West Virginia \AY
lowa 1A New York NY Wisconsin Wi
Kansas KS North Carolina NC Wyoming WY

Biblical Book Abbreviations

Abbreviations for books of the Bible should be consistent throughout the paper. They
are written with no periods. Abbreviations are used when specific chapter or chapter-
and-verse references are given, not when the Bible book name alone is used. Do not use
these abbreviations to begin a sentence or within a title.

Gen 1 Kgs Eccl Obad Matt Phil 1 Pet
Exod 2 Kgs Song Jonah Mark Col 2 Pet
Lev 1 Chr Isa Mic Luke 1 Thess 1 John
Num 2 Chr Jer Nah John 2 Thess 2 John
Deut Ezra Lam Hab Acts 1Tim 3 John
Josh Neh Ezek Zeph Rom 2 Tim Jude
Judg Esth Dan Hag 1 Cor Titus Rev
Ruth  Job Hos Zech 2 Cor Phlm

1Sam Ps (Pss) Joel Mal Gal Heb

2Sam Prov Amos Eph Jas
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TIPS FOR MAKING STUDENT RESEARCH PUBLISHABLE

Turning a project/thesis/dissertation into a publishable journal article takes some additional
thought and effort. Typically, a student research paper will have to be significantly shortened to
be published in a peer-review journal—and the expectation is that the article will be focused,
clear and succinct. The first step to preparing a publishable article is to decide which journal is
appropriate for your paper to be submitted to.

Once you have settled on several journals that seem appropriate, study the guidelines for
authors which the journal provides. The guidelines will give instruction regarding content,
format, and submission. To get published, the guidelines must be followed exactly.

Even though a journal article is shorter than your paper, the basic parts must appear. These
parts are shown below, along with suggestions for making the transition from academic paper to
journal article. If the work seems daunting, don’t let that deter you—it is worth the effort.

Student paper Publishable paper How to get there

Can tend to be wordy,
unedited.

Tight, no wasted words, highly
polished, edited well.

Write it, and then edit it repeatedly using
other readers if possible, until output is high
quality.

Can appear as if the
student is trying to stretch
the paper to meet the
minimum length
requirement.

General feeling that the
author has more to say than
what will fit and is trying to
reduce the paper to meet the
maximum length allowed.

Start with a slightly longer paper and reduce
it. Think how to best communicate the
research in the most word economical way
possible. A published  paper s
approximately 10-12 pages long.

Often lengthy general
introduction.

Introduction and Literature
Review are usually
combined and point to the
need for the present study.

Keep introduction short. Write a paragraph
or two, and move directly into your study.
The introduction must convince readers of
the timely relevance of your study and show
its place in current research.

Literature Review is
lengthy, contains a lot of
general information, not
many primary sources.
Often does not give
reasons for inclusion of
information.

Literature review is focused
and relatively brief. It contains
mainly primary studies closely
related to the research, not
general, introductory sources
or tangentially related past
work.

Read the general introductory studies for
your own information, if needed, but do not
put them in the introduction. A
project/thesis/dissertation contains a general
literature review occupying a whole chapter
which an article leaves out.

Frequent use of poor
quality sources, such as
general internet articles
on a topic, textbook
explanations, Wikipedia
definitions, etc.

Sources must be recent, and
closely related to the study.
High quality sources, such as
journals, recently published
books, and primary studies are
used. Review articles can be
useful summaries or sources
of expert opinion. Breadth is
sought to include multiple
perspectives.

Seek out high quality sources, especially
primary studies that are directly related to
your study. Ask more from your sources.
Mediocre sources make a mediocre paper.
There is plenty out there—make the effort
to find the good stuff.
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Student paper

Publishable paper

How to get there

Tends to use a lot of
quotations, even
lengthy ones.

Few quotations, but many
references; often multiple
ones in the same area
reinforcing a point of
view or line of research.

Make sure you understand what is being
said, and summarize/reduce bulky ideas
into smaller spaces using the support of
multiple sources.

Tends to rely heavily on a
few sources

Much more breadth of
sources; not overly dependent
on a chosen few.

Find out who are the key authors in a field
and cite them, but seek breadth, as well as
depth. One article per area discussed is not
sufficient coverage.

Analysis is heavily tied
to ideas found in the
literature. Little original
thought is evident.

Independent thinking is clearly
demonstrated; ideas come
from the author as well as the
literature; value added by the
author is clearly demonstrated.

Read more. Think more critically about
what you read. When you have read more
deeply and widely, you will begin to have
your own expertise to write about. Be
careful to link your own ideas to sources
contributing to or sharing perspectives you
develop.

Plagiarism is not always
carefully avoided.
Sometimes this is due to
poor technique,
sometimes because the
student does not believe
it is important.

Quotations and ideas of others
are carefully referenced.

This is an area which must be carefully
guarded in all papers. Reference carefully
at all times; take special care with internet
sites to acknowledge authorship correctly.

Personally created
summaries, lists, tables
or figures are rare; any
found in the text are
usually quoted.

Appropriate summaries,
figures, tables, or lists are
generated when analysis
requires some creative form of
synthesis to describe what was
learned. Figures from others
are almost never reproduced.

Seek opportunities to summarize, combine,
create, construct, and share ideas in the
form of personally created tables, figures,
or graphs. Resist the temptation to quote
other people’s analyses in your paper—
just reference them.

The referencing style is
often followed
mechanically, but not
well understood.

Evidence is given of clear
understanding of the
referencing style, be it APA,
MLA or another common
style.

Follow carefully the style manual indicated
by the journal in which you wish to
publish. Thoroughly learn the reference
style required. Have others who know it
check your paper.

Headings are frequent,
but not always
meaningful.

Headings are carefully
planned to divide a piece into
sections and subsections. The
purpose of headings is to help
the reader and provide a
“guide” through the article.

Edit your headings specifically. Don’t
overuse them. Consider the organization of
your piece so that the headings help
structure your article. Ask for expert
opinions.

Quotations are often
introduced in a wordy
way that does not show
true analysis of what
was said.

Quotations are rare; ideas from
sources are analyzed and
compared with ideas from
other sources. The referencing
style shows source
information, leaving the writer
free to make analytical
comments.

Make sure every word counts. Do not
begin sentences with authors’ names, but
rather with ideas. Compare/contrast and
synthesize relationship ideas adequately.
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Student paper

Publishable paper

How to get there

Often repetitive, loosely
organized.

Tightly organized by topic,
with each topic being
addressed once—no repetition.

Write an outline first; check the
organization before you finish. Print the
article and check its organization, making
sure that all similar ideas are in the same
place or are clearly associated by linking
terms. Do not repeat yourself.

Method section tends to
cover several pages.

Method is almost like a
formula—it is concise, dense,
and short—usually only a page
or so. Ethical considerations
are discussed briefly—maore
in-depth with vulnerable
participants. Data collection
details are summarized so the
reader can assess them, but not
explained in depth.

From the description of the methodology in
your paper, create a more concise
explanation, following the norms of the
discipline. Give enough information to
confirm to the reader that you are a careful
researcher, but avoid going into fine detail
that burdens the reader.

Analysis is often bulky
and repetitive.

Analysis is as concise as
possible. Tables and text
overlap very little, but rather,
complement each other.
Comments and references to
relevant literature are made
when appropriate.

You may need to write out a bulkier data
section at first and then reduce it. Do not
repeat yourself or describe uninteresting
data. Tell the important parts and say that
the rest confirmed prior research, was
insignificant, or contributed no new
knowledge.

Analysis tends to be
driven by numbers
which are sometimes not
interpreted adequately
and are often awkward
to read.

Analysis is written in as
simple a language as possible,
highlighting meaning,
interpreting statistics to
confirm trends or hypotheses
and practical applications to
the ideas of the research study.

Editing is needed here. Early drafts look
more like plain SPSS output. Later drafts
will read more like a reasoned explanation
or expository story, with numbers for
support.

Conclusion tends to
repeat analysis, rather
than bringing something
new.

Conclusion puts together all
the pieces found in the
analysis (without necessarily
restating them) and analyze
the whole, bringing in
references to literature,
interested parties, etc. The
conclusions are tied to the
data, but clearly represent the
author’s explanation of the
meaning of the data.

This requires careful writing, critical
thinking, disciplined creativity in forming
new syntheses suggested by the data and
discussion with your advisor. Put your
ideas in your writing; test them on your
advisor. Write, and be prepared and willing
to rewrite. Conclusions should be short and
substantive.




CHAPTER 8

SPS Research Protocol:
The Unabridged Complete Version






ADVENTIST UNIVERSITY OF AFRICA
School of Postgraduate Studies

RESEARCH PROTOCOL

Students who graduate from the School of Postgraduate Studies (SPS) at AUA will
have demonstrated proficiency in research through the selection and completion of a
project, thesis or dissertation. Each of these has a scholarly definition:

A project is considered experimental in nature; in that the researcher establishes
variables, designs interventions, and collects data to measure results of the
intervention. Students in any SPS Master’s degree programme can select to do a
project, which requires a Proposal Defence, but not a Final Oral Defence. A project
is supervised by a Primary Adviser and a Secondary Adviser. A project has an applied
aspect to it and can include the production of a manual, handbook, training or
workshop as part of the study process or outcome. For the Master of Science in
Applied Computer Science, a project must lead to the implementation of a software
product/tool that aims at solving a problem which is judged worthy of a research
project.

Typical project length: 70-80 pages excluding appendixes

Typical Computer Science project length: 45-80 pages excluding appendixes

A thesis is research that is more theoretical in nature, in that the researcher seeks to
establish a theory to explain an observed problem. Students who write a thesis may
also collect data and measure variables. However, the thesis results in a theory are
advanced to make a contribution to the field of study. A thesis must be defended at
the proposal level and also defended before a three to six-member Final Oral Defence
Panel at the end of the writing phase. A thesis is supervised by a Primary Adviser and
a Secondary Adviser and has an External Examiner who reviews the paper then joins
the panel for the Final Oral Defence.

Typical thesis length: 90-120 pages excluding appendixes

Typical Computer Science thesis length: 60-90 pages excluding appendixes
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A dissertation is highly academic, comprehensive, and widely considered the most
rigorous type of empirical research conducted by a student for a terminal degree. It is
expected to contribute new knowledge and advance scholarship in the field of study.
Students pursuing a PhD at AUA are eligible to write a dissertation. Before the
dissertation writing commences, the student must have passed the Comprehensive
Examination. The dissertation must be defended at the proposal level and also before
a five to seven member Final Oral Defence Panel at the end of the writing phase. A
dissertation committee comprises of a Primary Adviser and two Secondary Advisers.
There is also an External Examiner who reviews the paper then joins the panel of the
Final Oral Defence.

Typical dissertation length: 200-250 pages excluding appendixes

Typical Computer Science dissertation length: 90-180 pages excluding appendixes

The following Research Protocol guides the student step-by-step through the research
writing process from the proposal stage to final approval by the Dean.

THE PROPOSAL STAGE: Process for
Projects/Theses/Dissertations

1. After the designated research course is completed and passed, the student is
assigned a Primary and a Secondary Adviser by the Programme Leader (PL) in
consultation with the student, the Head of Department (HOD), and the Dean. In
the case of a Project, the Secondary Adviser may be assigned later in the work.

2. The student, with the assistance of the Advisers, develops a Proposal by following
the proposal and research design guidelines outlined in the SPS Research
Handbook.

3. When the Advisers approve the Proposal and sign the Proposal Examination
Form, a Proposal Defence Panel is formed by the PL, in consultation with the
HOD and the Dean, for the Proposal Defence by the student.

e For a Project or Thesis: The Proposal Defence Panel will consist of the two
Advisers, designated programme faculty, the PL, HOD, and the Dean.
Typically, the PL serves as the Chair.

e For a Dissertation: The Proposal Defence Panel will consist of the Primary
Adviser, two Secondary Advisers, designated programme faculty, the PL,
HOD, and the Dean. Typically, the PL serves as the Chair.
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4. A student will defend the Proposal only when the method of data collection is
clearly described, the instrument(s) of data collection is presented, and Ethics
Clearance has been obtained. To initiate Ethics Clearance, the student submits the
paper, along with the Informed Consent and all research instruments to the IERC
after these have been approved by the PA and the PL. The results of the Ethics
Review will be communicated to the PL in writing by the IERC Chair and a copy
of the Clearance will be given to the student for inclusion in the
project/thesis/dissertation.

5. In conjunction with the Ethics Clearance process, the Proposal and research
instruments will be reviewed by the AUA Editor for formatting and writing style
as per the SPS Research Handbook. Comments from the Editor will be given to
the PL so that they can be brought to the student’s attention.

6. After the Proposal is assessed and approved by the Proposal Defence Panel, using
the Research Proposal Evaluation Form, the student is informed of the outcome
of the Proposal Defence by the PL in writing with the Proposal Evaluation Result
Form. If no corrections are necessary, the student is authorized to collect data and
continue the research process under the supervision of the Advisers.

If corrections are needed, the student cannot begin collecting data until the
revisions are completed and approved. The student is expected to incorporate all
the suggestions of the Proposal Defence Panel under the guidance of his/her
Adviser (s). Submission of the revised proposal should not take longer than three
(3) months after the Proposal Defence.

o After revision, the Advisors verify that all the corrections have been duly
incorporated into the revised proposal, using the Correction Confirmation
Form.

e The Primary Advisor then sends the revised proposal directly to the PL who
confirms the revision and officially authorizes the student to collect data and
continue the research process under the supervision of the Advisers.

Note that if, during the Proposal Defence, changes are recommended by the Panel
that affects the ethics clearance, the student is not authorized to collect data. Instead, the
student must re-submit the proposal to IERC and obtain a new ethical clearance.

THE WRITING STAGE: Process for Projects

All SPS students must ensure that their citations follow the American Psychological
Association (APA) style and that their writing and formatting conform to the SPS
Research Handbook.
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10.

11.

12.

13.

The student submits each chapter of the Project to the Primary Adviser who
assists the student to reach the highest level of research and writing quality, and
also advises of areas that are incorrect, non-conforming to style, or are weak and
need modification. When the student has corrected all indicated areas to the
satisfaction of the Primary Adviser, the Primary Adviser provides written
approval to the student. Approval from the Primary Adviser affirms that the
Project adheres to academic research standards and SPS Research Handbook.
The Primary Adviser should copy the PL on all correspondence to the student.

After the Primary Adviser approves the Project, it is returned to the PL. The PL
then assigns the Project to the Secondary Adviser, who provides another critical
reading of the work and recommends any additional modifications to the student.
When this process is completed to the satisfaction of the Secondary Advisor,
he/she gives the student written approval and completes the Project Examination
Form. Then the Secondary Adviser sends the Project back to the Primary
Adviser to check the changes. The Primary Adviser gives approval of the paper
and completes Project Examination Form to submit to the PL, along with the
Project.

When the Primary Adviser approves the paper, he/she sends it directly to the PL.
Students should not submit approved Projects directly to the PL. Approved
Projects are moved through the process by the PL.

The PL requests grades for the Project from the Primary and Secondary Advisers
using the Grade Report for Advisers.

The PL gives the Project a final check, directs the student to fill the Printing and
Binding Form, and completes the Printing and Binding Form by adding the
grades. The PL submits the final grade to the Dean on the SPS Grade Sheet, as
per protocol.

The PL sends the Project, along with the Printing and Binding Form, to the
Research Office for review and editing. During this process, editorial changes
may be made to the paper to improve the grammar and flow of the paper or to
correct errors in style and format. Students and Advisers should not submit
Projects directly to the Research Office—submission is made only by the PL.

If substantive concerns are observed that may compromise academic quality,
such as plagiarism or ethics, the Research Director sends the Project back to the
PL with a written explanation of the concerns. The PL can give input and/or
return the Project to the student for corrections. If the Editor finds significant
errors in style and formatting, the Editor will return the Project to the PL, who
returns the paper to the student for corrections. Copies are also sent to the
Advisers so they can provide assistance to the student, if necessary. The student
sends the corrected paper back to the PL, who reviews the corrections made by
the student for accuracy. The PL then returns the paper to the Editor/Research
Director so that it continues through the process.
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14.After the Research Office approves the Project, it is sent to the PL who then sends

15.

16.

it to the Dean’s Office for final approval signature. The following signature lines
are authorized for the Approval Page:

e Primary Adviser

e Secondary Adviser
e Programme Leader
e Head of Department
e Dean

When the Dean has given final approval, and signed the Approval Page, the
Project is sent from the Dean’s office for printing and binding. The Dean’s office
submits the student’s name to the Registrar’s Office, where eligibility for
graduation is determined.

When the printing and binding are completed, one (1) copy of the Project is
delivered to the Judith Thomas Library for display in the collection.

THE WRITING STAGE: Process for Theses

All SPS students must ensure that their citations follow the American Psychological
Association (APA) style and that their writing and formatting conform to the SPS
Research Handbook.

17.

18.

The student submits each chapter of the Thesis to the Primary Adviser who
assists the student to reach the highest level of research and writing quality, and
also advises of areas that are incorrect, non-conforming to style, or are weak and
need modification. When the student has corrected all indicated areas to the
satisfaction of the Primary Adviser, the Primary Adviser provides written
approval to the student. Approval from the Primary Adviser affirms that the
Thesis adheres to academic research standards and the SPS Research Handbook.
The Primary Adviser should copy the PL on all correspondence to the student.

After the Primary Adviser approves the Thesis, it is returned to the PL. The PL
then avails the Thesis to the Secondary Adviser, who provides another critical
input to the work and recommends any additional modifications to the student.
When this process is completed to the satisfaction of the Secondary Advisor,
he/she gives the student written approval and completes the Thesis Examination
Form. Then the Secondary Adviser sends the Thesis back to the Primary Adviser
to check the changes. The Primary Adviser gives approval of the Thesis and
completes the Thesis Examination Form and submits it to the PL, along with the
Thesis.

113



19.

When the Primary Adviser approves the paper, he/she sends it directly to the PL.
Students should not submit an approved Thesis directly to the PL. Approved
theses are moved through the process by the Primary Adviser.

THE WRITING STAGE: Process for Dissertations

All SPS students must ensure that their citations follow the American Psychological
Association (APA) style and that their writing and formatting conform to the SPS
Research Handbook.

20. The student submits each chapter of the Dissertation to the Primary Adviser who

21.

22.

assists the student to reach the highest level of research and writing quality, and
also advises of areas that are incorrect, non-conforming to style, or are weak and
need modification. When the student has corrected all indicated areas to the
satisfaction of the Primary Adviser, the Primary Adviser provides written
approval to the student. Approval from the Primary Adviser affirms that the
Dissertation adheres to academic research standards and the SPS Research
Handbook. The Primary Adviser should copy the PL on all correspondence to
the student. After the Primary Adviser approves the Dissertation, he/she returns
it to the PL.

The PL then avails the Dissertation to the two Secondary Advisers, who provide
additional critical input to the work and recommend modifications to the student.
When this process is completed to the satisfaction of the Secondary Advisers,
they both give the student written approval and complete the Dissertation
Examination Form.

Then the Dissertation is sent back to the Primary Adviser to check the changes.
The Primary Adviser gives approval of the Dissertation and completes the
Dissertation Examination Form and submits it to the PL, along with the
Dissertation. Students should not submit an approved Dissertation directly to the
PL. Approved Dissertations are moved through the process by the Primary
Adviser.

THE FINAL ORAL DEFENCE STAGE: Process for Theses

23.
24,

25.

When the PL has the approved Thesis, he/she sends it to an External Examiner.

After the External Examiner has reviewed the thesis, the PL, in consultation with
the HOD and the Dean, sets a date for the Final Oral Defence.

The PL informs the members of the Final Oral Defence Panel that the oral
defence date has been set and assures the availability of members. The Final
Oral Defence Panel consists of the:

e Dean, Chair
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26.

27.

28.

29.

30.

o Head of Department

e Programme Leader

o Designated Faculty of the Program
e Primary Adviser

o Secondary Adviser

e External Examiner

Attendance at the Final Oral Defence is open to the public. Those present may
participate in directing questions to the student on the topic of his/her research,
when invited by the Dean. The audience will not be provided with a copy of the
student’s paper.

A Thesis defence shall normally be no longer than two hours and no shorter than
one hour in duration. At the start of the Final Oral Defence, the student is given
20 minutes to present his/her Thesis. The presentation is followed by the
examination of the Panel.

At the conclusion of the defence and following an executive session of the Panel,
the student is informed how the defence was scored:

e Very Good - No corrections necessary.

e Good- Minor corrections necessary; student may take up to one (1) month to
make the corrections and submit the revised Thesis to the Primary Adviser
through the PL.

o Fair- Major corrections necessary; student may take up to two (2) months to
make the corrections and submit the revised Thesis to the Primary Adviser
through the PL.

o Fail- Thesis is not accepted; the student must begin the process afresh.

If revisions to the Thesis are necessary, the PL communicates them to the student
and Primary Adviser, along with the timeframe given to finish revisions. This
will be provided in writing and the student is expected to be diligent in making
revisions. These revisions are done in consultation with the Primary Adviser,
who then confirms that all the revisions have been done satisfactorily and
submits the Final Thesis Correction Confirmation Form, along with the Thesis
to the PL.

The PL gives the Thesis a final check, directs the student to fill the Printing and
Binding Form, and then completes the Printing and Binding Form by adding the
grades. The PL submits the final grade to the Dean on the SPS Grade Sheet, as
per protocol.
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31.

32.

33.

34.

35.

The PL sends the Thesis, along with the Printing and Binding Form, to the
Research Office for review and editing. During this process, editorial changes
may be made to the paper to improve the grammar and flow or to correct errors
in style and format.

If there are substantive concerns about academic quality, such as plagiarism or
ethics, the Research Director will direct the Thesis back to the PL with a written
explanation of concerns. The PL can give input and/or return the paper to the
student for corrections. If the Editor finds significant errors in style and
formatting, the Editor will return the paper to the PL to be sent to the student for
corrections. Copies are also sent to the Advisers so they can provide assistance
to the student, if necessary. The student sends the corrected paper back to the
PL, who reviews the corrections made by the student for accuracy. The PL then
returns the paper to the Editor/Research Director so that it continues through the
process.

After the Research Office approves the Thesis, it is sent to the PL who then sends
it to the Dean for final approval and signature. The following signature lines are
authorized for the Approval Page:

Primary Adviser

o Secondary Adviser(s)
e External Examiner

e Programme Leader

e Head of Department
e Dean

When the Dean has given final approval, and signed the Approval Page, the
Thesis is sent from the Dean’s office for printing and binding. The Dean’s office
submits the student’s name to the Registrar’s Office, where eligibility for
graduation is determined.

When printing and binding are completed, one (1) copy of the Thesis is delivered
to the Judith Thomas Library for display in the collection.

THE FINAL ORAL DEFENCE STAGE: Process for Dissertations

36.

37.

When the PL has approved the Dissertation, he/she sends it to an External
Examiner.

After the External Examiner has reviewed the dissertation, the PL, in
consultation with the HOD and the Dean, sets a date for the Final Oral Defence.
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38.

39.

40.

41.

42.

The PL informs the members of the Final Oral Defence Panel that the oral
defence date has been set and assures the availability of members. The Final
Oral Defence Panel consists of the:

e Dean, Chair

e Head of Department

e Programme Leader

o Designated Faculty of the Program

e Primary Adviser

e Two Secondary Advisers, one of whom is the methodologist
e External Examiner

Attendance at the Final Oral Defence is open to the public. Those present may
participate in directing questions to the student on the topic of his/her research,
when invited by the Dean. The audience will not be provided with a copy of the
student’s paper.

A Dissertation defence shall normally be no longer than two and a half hours
and no shorter than two hours in duration. At the start of the Final Oral Defence,
the student is given 30 minutes to present his/her dissertation. The presentation
is followed by the examination from the Panel.

At the conclusion of the defence and following an executive session of the Panel,
the student is informed how the defence was scored:

e Very Good - No corrections necessary.

o Good- Minor corrections necessary; student may take up to one (1) month to
make the corrections and submit the revised Dissertation to the Primary
Adviser through the PL.

o Fair- Major corrections necessary; student may take up to two (2) months to
make the corrections and submit the revised Dissertation to the Primary
Adviser through the PL.

o Fail- Dissertation is not accepted; the student must begin the process afresh.

If revisions to the Dissertation are necessary, the PL communicates them to the
student and Primary Adviser, along with the timeframe given to finish revisions.
This will be provided in writing and the student is expected to be diligent in
making revisions. These revisions are done in consultation with the Primary
Adviser, who then confirms that all the revisions have been done satisfactorily
and submits the Final Dissertation Correction Confirmation Form, along with
the Dissertation to the PL.
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43. The PL gives the Dissertation a final check, directs the student to fill the Printing
and Binding Form, and completes the Printing and Binding Form by adding the
grades. The PL submits the final grade to the Dean on the SPS Grade Sheet, as
per protocol.

44. The PL sends the Dissertation, along with the Printing and Binding Form, to the
Research Office for review and editing. During this process, editorial changes
may be made to the paper to improve the grammar and flow or to correct errors
in style and format.

45. If there are substantive concerns about academic quality, such as plagiarism or
ethics, the Research Director will direct the Dissertation back to the PL with a
written explanation of concerns. The PL can give input and/or return the paper
to the student for corrections. If the Editor finds significant errors in style and
formatting, the Editor will return the paper to the PL to be sent to the student for
corrections. Copies are also sent to the Advisers so they can provide assistance
to the student, if necessary. The student sends the corrected paper back to the
PL, who reviews the corrections made by the student for accuracy. The PL then
returns the paper to the Editor/Research Director so that it continues through the
process.

46. After the Research Office approves the Dissertation, it is sent to the PL who then
sends it to the Dean for final approval and signature.

The following signature lines are authorized for the Approval Page:
e Primary Adviser

e Both Secondary Advisers

e External Examiner

e Programme Leader

e Head of Department

e Dean

47. When the Dean has given final approval, and signed the Approval Page, the
Dissertation is sent from the Dean’s office for printing and binding. The Dean’s
office submits the student’s name to the Registrar’s Office, where eligibility for
graduation is determined.

48. When printing and binding are completed, one (1) copy of the Dissertation is
delivered to the Judith Thomas Library for display in the collection.

Updated and voted by the SPS School Board: August 26, 2019
Update accepted by the Senate: September 12, 2019
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CHAPTER9

Sample Pages, Forms and
Grading Assessments






Sample Pages for Written
Project/Thesis/Dissertation

These pages demonstrate the format/style for pages in the project/thesis/dissertation
proposal or final paper.

Instructions

The boxes that look like the one above give instructions for how the page is to be
formatted. Sometimes all instructions could not be included, so students must refer to
detailed instructions in the appropriate chapter. These boxes are not to be placed on your
paper—they only give you format/style instructions.

Follow the examples so that your pages conform to the proper style and format. The
Sample Pages are titled to be used with a project, thesis or dissertation—use the one for
your type of paper. If there is not a paper type on the Sample Page, it means that the
sample page is used for all types of papers.

The Sample Pages follow the order that the pages should appear in your paper:

Abstract

Title Page

Copyright

Approval Page

Dedication (optional)

Table of Contents

List of Tables (required if five or more tables appear in the paper)
List of Figures (required if five or more figures appear in the paper)
List of Abbreviations (required if five or more abbreviations are used at least
three times each)

Acknowledgements (optional)

Chapters 1-5

References

Appendix(es)

Curriculum Vitae
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Project
Thesis

Place the correct type for
your paper:

Dissertation

Abstract Page:

Centered on page

lines

locator

Title of paper:
All capitals
Block indent

Single line space, PROTECTABSTRACT

if more than two

No abbreviations
Have geographical

<«——| Start title at 2” (S5cm) from top

v

Niaster of Busines: Administration
Accounting Option

Adventist University of Affica

School of Postzraduate Stodiss

Align text left
throughout

paper

\

Title: AN ANMALYEIE OF THE FINANCIAL PERFORMANCE AMD
EFFECTIVEMESS OF THE INTEEMAL AUDIT OF THE LOCAL CHURCH

I 50UTH WEET LIEERIA COWFEREMNCE OF EEVENTH-Df™

ADVENTISTS Name format:

_ First Name Surname
Ruezzarcher: George I Davis

Primary Advizer: Mack Tenmyzon(CPA, PiD)<«———| Use correct degree(s) of adviser

Diate completed: Movember 2018

The purpose of the stady was o examines the extent to which internal audit
activities are carried out in South West Libena Conference. The study focuzed on
etfectivensss of the intemal audit as well as the financial performance of the
Conference in terms of tithe zrowth and financial performance indicator. While many
previous empirical studies hawe been done which suggest a relationship betwaen

aocoumting centrel practices and financial performance, litte iz known, a2t present,

Abstract pages are neither counted nor numbered

MARGINS
(throughout
paper):
Under Page
Layout tab,
select
Margins,
and custom
accordingly:
Left=1.5
Right=1.0
Top=1.0
Bottom: 1.0

Abstract was shortened for illustrative purposes; see Handbook regarding Abstract length.
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Title:

Two lines, double
space

More than two lines,
single space

Divide lines at logical
place

Try to form an

shape

Include a geographical
locator

No abbreviations, no
period at end

Project
Thesis
Dissertation

Name format:
First Name Surname

Adventizt University of Africa

School of Posteraduate Stndies

. _ - b TEENAGE MOTHERS: A CASE STUDY
inverted pyramid I ASIKIMA ODOBEN ERAKVA

DISTRICT, GHAMA

\ s /

yﬁ;ﬂu fulfillment
Place the correct type of your w

of the requirements for the dagTes

Master of Public Health

b:".
Jaonas Kwaku Darko

April 2019

THE IMPACT OF AMTEMATAT, HEALTH EDUCATION

»

Title Page:

Start first line 2 (5
cm) from top,

title of the research
at4” (10 cm),
description of the
research at 6” (15
cm), and

the word by at 8”

_ (20 cm)

\ Date:

Project: month of approval (no day)
Thesis: month of defence (no day)
Dissertation: month of defence (no day)

[

Title page is page i, but the number does
not appear on the page.
Page count starts with the Title Page.
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Copyright Page: not required, but encouraged.
Information is placed at bottom of page as shown.

No page number is shown, but page is couhke\d.

\

Copyright 2018 2 Jozeph Adsbomi
All Bights Beservad
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Approval Page Project:
Format page to look like this and fit on one page.

Title:

Two lines, double
space

More than two
lines, single space
Divide lines at
logical place

Try to form an
inverted pyramid
shape

Include a
geographical
locator

No abbreviations,
no period at end

THE IMPACT OF DISABILITY % THE WORESHIP EXPERIENCE AND

SEVEMTH-DAY ADVENTIST CHURCH MEMEERS
INWEST ZIMEABWE

GENMEFRAL PARTICIPATION BY VISUALLY CHALLENGED
Approval Page:

presanted im partial fulfillent

of the requirements for the dezres
hiaster of Arts in Leadership

Start title of the
research 2” (5 cm)
from top,
description of the
research at 4” (10
cm),

the word by at 6”
(15 cm), and

the word
APPROVED BY at
77 (17.5 cm)

Name format:
First Name Surname

APPROVED BY:
Primary Advizer Programme Directar, AT aad
Hakule Eizanza, Dhlin, PhD Whaza Wyvakora, FhD

Secondary Sdviser
Larry Evans, Dfin

Diate:

Whasa Myakors, PhD

/

Haad of Department, Social Sciencas

Dimiel Garm, DePH

Date is filled by Dean when signed.
Add solid line after colon.

Approval Page has no page humber
although it is counted as a page.

Diaan, School of Posteraduste Smdies
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Approval Page Thesis:
Format page to look like this and fit on one page.

Title:

Two lines, double  —
space

More than two lines,
single space

Divide lines at logical
place

Try to form an inverted
pyramid shape

Include a geographical
locator

No abbreviations, no
period at end

DETEREMIMANTE OF EREAST CAMNCEF. AWAREMESE
AMD SCEEENING PEACTICES OF WOMEM

N TAMALE, GHANA

\ Approval Page:

Start title of the
research 2” (5 cm)
from top,
|description of the

research at 4” (10
. cm),
A thesis the word by at 6”

prezented m partial flfillment
of the requirements for the degres
Bulaster of Public Hezlth
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Chapter numbers can be spelled
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Start 2”” (5cm) from top for
pages with titles

Double space between chapter CHL J«—— Written in uppercase.

Chapter 1), just be consistent
throughout chapters.

—_—

v

number and title S N N‘/ Centered.
INTRODTUCTIO

Triple space between title and

text

o
the leading canze of morbidity and mortality among

women, accounting for about 17.5 million cazes and nins million deaths in 2013,

Braast cancer i3 now ranked the most commoan cancer worldwide, increazad from
1.7 million incident cases in 2005 to 2.4 million cases in 2015 (Fitzmaorics ot &l
2017). The estimated munber of pew cases each year is expected to reach 15 million
by 2023, with 60% of those cazes ooouring in low and middle-mcome conniries
(Takeda ot al., 2000).

Inzights mto the epiderniology and risks associated with breast cancsr have

zeen Telative mprovernents in the responsa to brezst cancer across popualation

Eroups, particnlarly in high-mcome settings. However, in Africa and many low- and

middle-income countries (LAICs), sevaral challenzes including poor health

MARGINS
(throughout
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Margins,
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accordingly:
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Right=1.0
Top=1.0
Bottom: 1.0

infrastmctare, mcomplete vital regisirations, lack of adequats population awareness,

Page numbering in Chapter one begins with
Arabic number 1 and continues consecutively
throughout the paper.

l=vels of famale education, a3 well as

fromn breast cancer {Adelove et 2l 2018).

Throughout the world, a 0zis of ora

(Eomen, 2014).

challenze it is astimated that mara

2zt cancer is made every 19 seconds

In poorly resourced seftings, acceys to services offerme breast screening iz still 2

0% of women in low and middle
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between
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treatrnant have bean shown to be the most efective methods to address the

idly increzsing global health barden (Liw et 2, 2017). Ereast scresning is the

v way to dizamose or detect early any sbmormality with the breast. However,

are shown. el connected to scresning is awareness.

Mlore zo, the independent varizbles show that factors such 2= sacio-
demographic varizble: and the general perceptions of women rezarding bresst cancer
affect the extent to which wornen ars intarested in becoming awars of the dizeass and
alzo enEaging in screening practices. Fizure 1 shows the relationships among the

Leave two variahles in fhe stady.
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spaces before | ——»
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tables and
figures.
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I Age
1 Falisi
3. Etmicity
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1. Bisks Practices
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3. Action taken upan detection of
Lo

Figure . Concepriial Framework:

Figure titles go below the figure, numbered
consecutively with no decimals.
Quantitative studies show variables.
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CHAPTER. 2

LITERATURE REVIEW

Cancer

Cancer is an incyeasmg problem in Africa doe to several factors inchyding
aging papulations and the increasms adoption of risk behavior such as unbaalthy
diets, lack of physical exercizs, smoking, alcobol consumpton, obesity, plryzical
inactivity, and reproductive behaviors (Parkin, et al, 2018). Ferlay eval (2013)
pradict that the mmber of new cancer cases per vear will increase by 70% m Africa
betvvean 2012 and 2030 due to demographic chanees alone. Also, Bray (2014)
atirilnates the rise in cancer moidence to the increasme wrhanization of Afica and the
aszocizted lifesmvle changes

Arcording to the World Health Orgamization (WHO), Breast cancer is tha
most Tequent cancer Mong women mpacting 2.1 million women ezch vear, and
alza canses the greatest mumber of cancer-related deaths among wornen. In 2018, it
was estimated that §27,000 womsan disd Fom breast cancer — that i= approximataly
15% of &ll cancer deaths amonz women While bresst cancer rates are higher smong

women in higher-incoms regions, rates ans increasing in nearky every region globally.

At least two lines of text must appear after
the heading at the bottom of a page.

Eroast concar iz “She moct corveo CRCEE SMons wamen in 24§ of the 34 countries m

N

Breast Cancer Epideminolosy and Incidence
It = zaid that the control and prevention of breast cancer have m Afca is

bazically lmited, partly doe to a lack of reliable epidemiolegic risk factor dats and
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CHAPTEE. 3

FESEARCH DESIGHN AMD METHODOLOGY

If the first L
section of a
chapter This chapter discusses the research design the population znd

serves as an
introduction,

:ZQ:ﬁgdngé be B - eideration, data callection procedires and the method of data analysis.

such. chapter presents the basic techniques and tools for data collaction and

ling procadure, the meumant for data collactions, the ethical

analyziz. It shows the methods wsad for how data were collected and

shsequently analyzed.

Leave a double space

Research Design between two successive
Type nfsmdf/L headings.

There can never be three
The resaarch design iz a descriptive, cross-sectioy  SUCCessive headings.

Level 2 heading:  \e of assessing the ectent to which the internal andit is being practiced

left margin, title
case, bold chirches and detenmining the level of the financis] perfonmance.

Study Setting
Thiz research was conducted m hloarovia which is the capital city of
Liberiz. Libaria is located on the West coast of Africa and share barders with

Guinea Ivary Coast and 3isrra Leons oa the Morth, Ezst and West

respactivaly.
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CHAPTEEF. 4

FESULTS AND DISCTUSEI0N

. _ _ _ .| Use figures
Thiz chapter presents the findings, the analyziz and the interprets to express
o . number 10
g d through research the effiect of employ o
gathare £h res QUESTIOMRAIE an ot EHpEEYES HENYER and above.

the achisvement of organisation goals, the caze of hialawi Adventist University.

The findings are pressnted according to the sequence of the research questions,

The Response Rate

The employees under study were 241, Cut of the 241 employ

the sample size. 131 guestionnzires ware distributed to the reg

ware rerieved representing 85 6% retrieval rate. Iine gquesponnaires wers

discarded az were not properly responded to leaving 144 guestionnaires that v

fully respanded to and that represented 80.6% or 81% response rate. Therefpre, the
results pressnted and the conclosions made from this study are from the 81%%

response rate and the researcher felt adequate to draw conclozions out of this.

Demographic Characteriztics of the Respondents
Thiz section prezents the demographic information of the respondents bazad
on their age, gender, years of sarvice, education level, job category and job states.

These categories are shoom on the frequency dismribution tables.
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Place table titles above the table.

Leave a
single
e
_ _ - M between
Tabie 1. Socio-darosraphic Characteristics of Famale Bespand .
Charactenste (_2tRENTY Frequency Ty title and
Aee JE: ) JEH table.
23-I2 B3 Iz
0-34 51 151
I5-32 7 6.8
20 -4 aa 5.1
45— 42 40 11
50 amd Abane 37 L
Tozl 304 104
Marrtal Stafus smzle ] iy
Marmed 231 G4
Separated 11 18
Divorced 1z 3.0
Total 305 100
Feligion Christian 133 EER]
Maozlem 263 G6.4
Tozl 304 100
Educatronal Tevel Ho fomal education 151 EER
Primary 4 6.1
JHS &z 40
SHS 119 1
Tertiary 7 6.8
Total 305 100
Etmanty Akan a0 1
Bizza 2 a0
Builza 14 33
Diagao 2 24
Diagomiba 245 621
Frafia 3l 18
O 3 0.8
Epakomba o 13
Mamprusi 3l 18
Mazhie 10 i3
Total 305 100
Comrmunty) Arsa Comct Aboabo £ Bl
Bilpala 11 18
Chansli 33 gz
Diabakpa 30 1.4
Cukpezn L] 13
Cunibing 33 g3
Fukmo 2 a0
Lamazhezn 58 14.6
Mlozhie Zonzo 39 Lg
Sabonzida 30 1.4
Sakmzaka 12 3.0
Tizhezn 44 111
Zogheli ER] g3
Total 304 LK

Source: Field Survey, 20128

v

<
<

Tables should fill the width of the page. To achieve this:

Select the table (top left-hand corner). Then go to
TableTools > Layout and under the Cell Size group, select
AutoFit > AutoFit Window.
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Write (continued)

umber on the
following page, and

Tabie 10 (comimedy. Distimricn o (tAD1@ continues) at

Show all headers at the tops of Chrch growih h fth
columns for convenience of the marvesien”_|x_|vo |v | 1€ DTIOM 07 e
d dk | q Prowiing 5o [% | first/page of the
T
r?a erdan | efe_p (tZO umns ana rows m.l"“};mu‘:;}_!m table.
aligned as in first page. wdiman
departmental
leadars who are
kingdom minded
on bi-anmual
basis.
Teaching and 180 |0 40 |40/ | 220 40 Q18182 [ 12
lead tha
leaders to
d d and
Tabie 10 Distribation of Church Growth Intarvention 0 [35/]35 |20 33 0.15808 |13
Church growth Total Total
intervention N N+ | Y Y*1 | response | score | RIT Rank
Are the leaders 120 |0 100 | 100 | 220 100 0434533 1
zerving a big part
of chuarch cultura?
Does the crch | 120 | O 100 | 100 | 220 100 | 043433 |1 0 0 30 {220 30 0.13636 |14
care for children
and Vouth?
Are the Youth 125 |0 85 [95 |220 a3 043182 [ 3
imvolved in
church programs? _ _ _ _ _
Dothe leaders | 130 |0 |20 | 20 | 220 T 040000 | 4 VRN N 5 [oI1see |15
utilize holistic
stewardship
practice?
Do the chrch 150 |0 %0 |90 | 220 o0 040809 | 4
leaders have &
emuine desire far .;
church growth? £
Equippinz and | 150 | @ | 70 | 70 | 220 70 | 031818 | 6
empowering the
departmental
leaders for a life
of service within
the God's church.
Preparing the 150 |0 0| T0 [220 T0 031818 | &
leadars to be
responsible
citizenship in the 50
church, in this
warld and the
warld o come.
Do the chnrch 150 |0 OO Te [220 T0 031818 | &
leaders make
visitation prierin
of charch
program?
Do leaders 150 | O &) [ 40 | 220 60 027273 | @
confront issues
lovingly?
Daveloping 170 50 [0 220 50 0.22727 | 10
leadrship
appraizal and
further wraining
opporfunitiss far
leadars.
(tahls contfue)

Tables should typically fit on one page. If they
have to be continued, present as shown here.
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Tables can be in landscape view if data set is large.

All table rules apply; title number/title are on left margin.
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Page number is placed in same position as vertical pages.
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Figures can also display data nicely.

Figures and Tables must always be introduced by number before they are

shown.

45 vears, 15 (25.0%:) were aged by

important factor kazed on the findings of this swdy.

Al

25.0%

15-25 years 26-45 years

Fizure 1. Age Dhstmbufion of Study Respondents

i

34 {36.7%0) ware within the aze rangs of 26-
15-15 vears, and the least 11 {15.3%) ware

aged from 44 vears znd 2bove, 33 zeen in Figors 2. Age. if torms ouf, was an

Itis a good idea to add the
percentage amounts when
using graphic data where they
can be seen.

1B.3%

4t years

make sure data is readable.

Your paper will be printed in black and white, so avoid color and
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Displayed to follow the order that the pages
should appear in your paper.
All format rules apply.

CHAPTER 5

SUNLIARY, COMNCLUSION, AND RECOMMENDATIONS

Summary

Staksholders of hbwatalika schools cannot overcome the challenzes of speaking
Engzlish by chance, expecially if they want to achisve excellence in spoken English by
leamers at the school. The practice of spesking English must bacome 3 more cansciously
and contirmansly hiabit by all the leamers. Teachsrs and the adminiztration must implement
policies and programs which will inevitably empower and campel smdents to develop the
culture of practicing speaking Enzlish. In :o doing, most of them will have thedr skills of
speaking English improved. Bdbrvataliks should creste systarns that encourage, reward amd
suppart the motivation styles of English speaking at the school. All things being egual
teachears should be at the forefront of the program. Spezking English iz needful in the inside
as well a3 an oniside classromm. host leamers hardly speak English while others ssem to
zpeale it pccasionally.

To improve snd overcoms the challsnges of speaking English leamers anzht nat to
think of their EFL only. They should not have 3 pessimistic attitede because their native
language iz Chichewa,” thersfors, they cannot master another languaze ™ Thiz mindset will
not help them learn and kmow other langnazes like English It would even canse English
Speaking Difficulties (ESD). With such ESD=, one would suffer from lack of confidence,
lzck of understanding, forgeming vocsbulary when spealdng, and poor prommciation. That

iz why leamers roust be encourazed to nse Englizh when spesitng.
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Initial appendix cover sheet

The cover sheet has no page number,
although it is counted as a page.
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Appendixes usually appear in the order
they are presented in the text.

Appendixes can be titled with numbers
(Appendix 1), or alphabets (Appendix A).
Just be consistent with use of one or the
other throughout the document.

Questionnaires
appear in the
appendixes as
they were
presented to the
respondents.
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APPENDIX 1
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If you have to
include material
that cannot be
reformatted, make
sure that the text is
still visible after the
scanning/cropping FERMISSION TO COMDUCT RESEARCH
process.

APPEMNDII 3
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£ Mbwatalika Secondary School

P O Box 1416

Lilongwe.
24™ May 2016

Mbwatalika Secondary School
PO Box 14 16

Lilongwe
Dear Madam,

RE: ACCEPTANCE FOR YOUR RESEARCH PROJECT STUDY

According to your application that you showed interest to do your research study here at the
school, we are pleased to tell you that the ADCOM of Mbwatalika schools accepted your

application and that you can go ahead when you are ready.

Looking forward to seeing you prosper in your studies.
Yours Sincerely,
Y. Kawerama ) i

Acting Registrar ¥
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This is only an example.
Refer to Handbook regarding
what to include in CV.

Personal Information

Surrame: Finished
HName: Withdzzres
HNatiorality: Liberian

Education
Tn=titution:

Diate- 1983
Diegree

Tnstitution:

Diate- 1983 - 2001
Diegree

Institution:

Diate- 2013 - 2014

Email: fmishednZana ac ke

CV is not an appendix.

CURRICULUM VITAE

William V.5, Tubwman Hish Schoed, 12" Street, Moarovia,
Libaria

Semior High Bchool Education

Hizh School & Mattona] Examiretion Centificates

University of Liberiz, Cpito] Bill, Moarovia, Liveria

BBA - Accoumting Biajor, Economic Minor

Adventist University of Africa

Diepree MEA Accounting Candidats
Relevant Professional Experience
Diate: 01002000 — Present
Location Monroaiz, Likeriz
CompamyarEarisation West Afiica Union Mizzion of Seventh-day Adwverntists
Bazition Treasumar
Diate: 010133 - 51122015
Location Momroviza, Liberia
CompamyiorEamisation South Wast Liberia Conference of Seventh-day Adventists
Paszition

Treay
" CV has the last page number of the document.
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Samples of Consent and Permission Forms

Use these pages for ethics requirements.



Informed Consent

Note to Researcher: Areas to be filled are shown by parentheses and italics. These
should be completed before given to participants.

You are being asked to participate in a research study entitled: (Title of your study).
The purpose of this study is (give a BRIEF sentence about the purpose of your study).

In order to participate in the study, you will be asked to fill out a questionnaire that has
(number) items. Finishing the questionnaire should take approximately (amount of time
for average person to complete) minutes. (Add other research instruments, if applicable,
and state what participants have to do and how long their participation should take them
to complete.)

Your participation in this study is voluntary. If you sign the bottom of this Form, it means
that you are giving your consent to be in the study. You will NOT write your name on
the questionnaire and this Form is separate from the questionnaire—this ensures that
your identity will not be revealed. No one other than the researcher(s) and advisers will
have access to the data. All data will be kept on a password protected computer. (If this
statement is not true of your study, delete it and state how data will be protected.)

If you do not want to participate in the study, do not begin filling the questionnaire or
participating in other research activities. If you start to fill the questionnaire and decide
you do not want to participate, stop filling it and give it to the researcher. There is no
penalty for not participating and your questionnaire will not be used.

If you participate, you will contribute to knowledge about (briefly state the benefits of
this knowledge), which may help to (give a brief statement of benefits). There are no
identifiable risks in participation (or, if there are risks, discuss them here).

The researcher will answer any questions that you have about the study and you should
ask them now.

If you have complaints or concerns about this research, please contact the Chair of the
AUA Institutional Ethics Review Committee:

(Give the name of the AUA IERC Chair and his/her email address here. You can get this
information from your Programme Leader.)

Thank you.
(Include your name and programme)

By signing below, | agree to participate in this research.

Signature Date

This study has been approved by the AUA Institutional Ethics Review Board. (Only add
this statement when approval has been given.)
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Parent or Guardian Permission Form
for Research Involving a Minor

Note to Researcher: This is a sample. Your permission form does not need to be
formatted exactly like this one, as long as it includes the necessary elements contained
here.

For research involving minors, child assent should be sought whenever possible. At
times, this may entail creating a separate consent document for parents and children
(each written in age-appropriate language) and each must be signed. At other times,
parents may be required to make the decision for the child. Please be aware that
participants give consent, parents give permission, and minors give assent. Your
documents should contain the appropriate terms.

Areas to be filled are shown by parentheses and italics. These should be completed
before given to participants.

Title of Project: (give title written in plain, non-jargon language; can be brief)
Researcher: (your name and email address or phone number)

Your permission is being sought to have your child participate in this study. Please read
the following information carefully before you decide whether or not to give your
permission.

Purpose of the research: (make a brief and clear statement)
Procedure to be followed: (state what child will have to do in the research)

Discomforts/risks: (This can be the following sentence or modified to meet the need of
your study.) There are no foreseeable discomforts or dangers to either you or your child
in this study.

Incentives/benefits for participation: (This can be the following sentence or modified
to meet the need of your study.) There are no direct benefits to your child from
participating in this study. However, the results of this study will (add the potential
benefits of your study to humanity/society/community/church here).

Time duration of participation: (state how long participation will take)

Statement of confidentiality: All records are kept confidential and will be available
only to the researcher. If the results of this study are published, the data will be presented
in group form and individual children will not be identified.
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Voluntary participation: Your child’s participation is voluntary. If you feel your child
has in any way been coerced into participation, please inform the Chair of the AUA
Institutional Ethics Review Committee, (add the name of the Chair of the Committee
here) at the email address: (add the Chair’s email address at AUA; your Programme
Leader can give you this information) or the phone number: (add the phone number at
AUA; your Programme Leader can give you this information). This letter can be read
to your child, if age-appropriate, and inform your child that participation is voluntary.
At the time of the study, your child will once again be reminded of this by the researcher.

Termination of participation: If at any point during the study you or your child wishes
to terminate the session, we will do so. There is no penalty for ending participation.

Comments, concerns or complaints regarding the research should be directed to:
The Chair of the AUA Institutional Ethics Review Committee, (add the name here, as
you did above) at the email address: (add the Chair’s email address at AUA, as you did
above) or the phone number (add the phone number, as you did above).

This research has been reviewed and approved by the ethics committee at the Adventist
University of Africa. If at any time before, during or after the study your child
experiences any physical or emotional discomfort that is a result of his/her participation,
contact the Chair of the Institutional Ethics Review Committee, (add the name here, as
above), using the email address: (add email address here) or phone number: (add the
phone number at AUA here.)

Signing the form below will allow your child to participate in the study.
If you do not sign and return this form, the researchers will understand that you
do not wish to allow your child to participate.

Parent Signature

I, the parent or guardian of , a minor
who is years of age, give my permission for his/her participation in the
research named above.

Parent/Guardian Signature Date

Printed name

Child/Minor Signature, if appropriate

I, , agree to participate in the research
named above. | understand that this is voluntary and that any questions | have about this
research have been answered.

Signature of Child/Minor Date
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Non-Disclosure Agreement for Participants in
Research Interviews or Focus Groups

Note to Researcher: If participants must sign an Informed Consent, the participant must
read and sign the Informed Consent BEFORE being given this Form for completion.

Non-Disclosure Statement:

You are being asked to read and sign this Form because you are invited to be a participant
in a focus group, an interview or a discussion. As a participant, you will be asked to
voice your opinion and others will voice their opinions. You are asked to NOT disclose
anything that was said during the focus group, interview or discussion. By agreeing to
participate, you agree NOT to disclose to others outside this event anything said within
the context of the focus group, interview, or discussion.

| agree to maintain the confidentiality of the information discussed by all
participants and researchers during the focus group/interview/discussion session.

____1 do not agree to the confidentiality requirements of this study and decline to
participate.

Name Date:
Signature:
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Permission to Use Direct Quotations for
Participants in Research Interviews
or Focus Groups

Note to Researcher: If participants must sign an Informed Consent, the participant must
read and sign the Informed Consent BEFORE being given this Form for completion.

Permission to Quote:

I may wish to quote your words directly in reports and publications resulting from this
interview, focus group or discussion. With regards to being quoted, please check yes or
no for each of the following statements:

Researchers may publish documents that contain quotations by me under the
following conditions:

E ;(e)s | agree to be quoted directly (my name can be used).

o Yes | agree to be quoted directly if my name is not published (I remain
o No anonymous).

E ;zs | agree to be quoted directly if a made-up name (pseudonym) is used.

By signing this consent form, you are indicating that you fully understand the above
information and agree to participate in this study.

Name Date:

Signature:
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Permission for Photography for Research Participants
in Any Pictures Taken by Researcher

Note to Researcher: If participants must sign an Informed Consent, the participant must
read and sign the Informed Consent BEFORE being given this Form for completion.

Permission to Use Photograph(s):

If any photographs or likenesses of you, a minor member of your family, or your property
have been taken during this research, we request your permission to use them in a
published document. Once the document is published, the photographs could appear in
media, such as the internet.

Permission to use your photograph(s)/likeness is voluntary. You do not have to consent
to participate in this study. You do not have to agree to have pictures taken or published.

In regard to publication of photographs/likenesses of me, a minor member of my
family, or my property:

O Yes[JNo || agree to be photographed and have the photographs used in a
publication.

O Yes ] No I give permission for a minor member of my family to be
photographed and the photograph used in a publication.

[ Yes [JNo | | agree that my property can be photographed and the photograph
used in a publication.

[JYes[JNo | I do not give permission for any of the above uses of my
photograph, likeness, minor family member, or property.

By signing this consent form, you are indicating that you fully understand the above
information and agree to participate in this study.

Name Date:

Signature:
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Proposal and Proposal Defence Forms



Proposal Title Page

Advemtist University of Africa
School of Postraduate Smudies

AMODEL SIMULATION OF ARTIFICIAL INTELLIGENCE

Insert the type of your paper:
Project

Thesis

Dissertation

Mlaster of Sciance in Applisd Computer Sclance

FOFR USE M THE HIGHEF. EDUCATION COMPUTEE. 2CIENCE CLASEROOM

Make sure
the name of
|t degree
you are
getting is
correct

Emmanmie] Owasy €&——m—

Name format:
First Name Surname

Tarmary 2019

Date: month and year you
submit proposal with no
punctuation
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Proposal Examination Form

To: Date:
Programme Leader

This is to confirm that:

Student Name

Projectd Thesisd Dissertation]

Title:

has finalized his/her proposal, including research instrument(s) and is now ready for
Proposal Defence and Panel examination.

Primary Adviser: Signature Date
Secondary Adviser: Signature Date
Secondary Adviser (If applicable): Signature Date
Programme Leader: Signature Date
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Research Proposal Defence Evaluation Form

Name of Student:

Projectl] Thesis[ Dissertation[]

Title:

Direction:Please carefully read the attached proposal and evaluate each section of the
proposal using the rating scale:

1 Below average
2 Average
3 Above average

Where youve rated “Below average,” specify the desired improvement in the space
provided.

Evaluation Statement Ratings Comments
(circle)

Title of the Study/Background Study

1. The title of the study properly captures the main 1 2 3
problem of the research.

2. The background of the study gives adequate 1 2 3
context to understand what the research is about.
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Evaluation Statement Ratings | Comments
(circle)
Problem Statement
3. The problem is relevant to the needs of society 2 3
and significant enough to add to existing
knowledge.
4. There is sufficient evidence in the problem 2 3
statement to convince the reader that the problem
is real and solvable.
5. The problem is focused enough to be 2 3
accomplished within a reasonable expenditure of
time, money and effort.
Research Questions/Hypotheses
6. If the study is quantitative, the research 2 3
questions/hypotheses align with the purpose and
variables.
If the study is qualitative, the research questions are
aligned with selected phenomenon.
7. The research questions/hypotheses taken 2 3
together answer the research problem.
8. There is a direct link between the research 2 3
guestions/hypotheses and the
conceptual/theoretical framework.
Theoretical/Conceptual Framework
9. The theoretical/conceptual framework identifies 2 3
the concepts/variables and the presumed
relationships among them.
10. The theoretical/conceptual framework 2 3
demonstrates understanding of relevant
reviewed literature.
11. The theoretical/conceptual framework is linked 2 3
to the research problem/questions/hypotheses.
12. Key concepts/variables and terminologies in the 2 3
study are defined according to how they are
used in the study.
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Evaluation Statement

Ratings
(circle)

Comments

Review of Related Literature

13.

There is adequate exploration of literature
relevant to the research problem and questions.

2 3

14.

The reviewed literature identifies gaps and/or
limitations in existing research, therefore
providing a context for the study.

15.

The literature review is organized systematically
and logically based on the key
concepts/variables in the study.

16.

The literature review is coherent in a way which
offers new insights into the topic.

Research Methodology

17.

The study clearly identifies an appropriate
research design.

18.

The study demonstrates why the chosen design
and methods are well suited to the study.

19.

The study population and sample procedures are
clearly identified and described.

20.

Sampling is clearly described according to the
standards of the selected research design.

21.

The proposal identifies the appropriate data
analysis techniques for addressing the research
guestions.

22.

The proposal discusses ethical issues that may
arise from the study and how to safeguard the
participants and data collected.

Research Instruments (s)

23.

The instrument(s) for gathering data is/are
clearly identified and described.

24,

The instrument(s) for data collection contain all
the constructs and variables in the research
guestions.

25.

The instrument validation processes are
indicated.
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Evaluation Statement Ratings Comment

(circle) S
26. The instrument reliability processes are 1 2 3
indicated.
References

27. The proposal provides a list of cited references 1 2 3
according to the APA reference style.

28. The references are current and relevant. 1 2 3
Other Considerations
29. The proposal is free from typographical and 1 2 3

grammatical errors.

30. The student demonstrated a clear understanding | 1 2 3
of the study.

31. Student’s overall grasp of the subject of his/her | 1 2 3
research.

Overall Score =

Other General Remarks

Score Interpretation
81- 93 | Approved, with minor or no correction
61- 80 | Approved, revise — no need to re-submit
41-60 Revise, must re-submit

Below 41 | Denied, re-write proposal

Overall Evaluation: Approved, with minor or no correction
Approved, revise — no need to re-submit
Revise, must re-submit

Denied, re-write proposal

Evaluator: Signature:

Date:
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Research Proposal Defence Evaluation Form
for Computer Science

Name of Student:

Projectd Thesisd Dissertation[]

Title:

Direction: Please carefully read the attached proposal and evaluate each section of
the proposal using the rating scale below:

1  Below average
2  Average
3 Above average

Where youve rated “Below Average,” please specify the desired improvement in the
space provided.
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Evaluation Statement

Ratings (circle)

Comments

Title of the Study/Background Study

1. The title of the study properly captures
the main problem of the research.

2

3

2. The background of the study gives
adequate context to understand what
the research is about.

Problem Statement

3. The problem is relevant to the needs of
society and significant enough to add
to existing knowledge.

4. There is sufficient evidence in the
problem statement to convince the
reader that the problem is real and
solvable.

Evaluation Statement

Ratings (circle)

Comments

5. The problem is focused enough to be
accomplished within a reasonable
expenditure of time, money and effort.

1

2

3

Research Questions/ Hypotheses

6. The research questions/hypotheses 1
align with the purpose and variables.

7. The research questions/hypotheses are | 1
appropriate to answer the research
problem.

Review of Related Literature

8. There is adequate exploration of 1
literature relevant to the research
problem and questions.

9. The reviewed literature identifies gaps | 1
and/or limitations in existing research,
therefore providing a context for the
study.

10. The literature review is organized ina | 1
logical way.

11. The literature review is coherent in a 1
way which offers new insights into the
topic.

Research Methodology

12. The study clearly identifies an 1
appropriate research design.

13. The study demonstrates why the 1
chosen design and methods are well
suited to the study.
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14. The study population and sample 1 2 3
procedures are clearly identified and
described.
15. Sampling is clearly described 1 2 3
according to the standards of the
selected research design.
16. The proposal discusses ethical issues | 1 2 3
that may arise from the study.
Oral Presentation
17. The presentation is professional and | 1 2 3
attracted the audience’s attention.
18. The slides (visual aids) are well 1 2 3
organized, clear, readable and
relevant.
19. The student has used the proper 1 2 3
language and terms.
20. The student showed clarity and 1 2 3
completeness in responding to
questions.
Evaluation Statement Ratings (circle) Comments
References
21. The proposal provides a list of cited | 1 2 3
references according to the IEEE
Trans reference style.
22. The references are current and 1 2 3
relevant.
Other Considerations
23. The proposal is free from 1 2 3
typographical and grammatical
errors.
24. The student demonstrated a clear 1 2 3
understanding of the study.
25. Student’s overall grasp of the subject | 1 2 3
of his/her research.

Overall Score =

Other General Remarks
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Score Interpretation

66 - 75 | Approved, with minor no correction

49 - 65 | Approved, revise —no need to re-submit

33 -48 | Revise, must re-submit

Below 33 | Denied, re-write proposal

Overall Evaluation: Approved, with minor or no correction

Approved, revise — no need to re-submit
Revise, must re-submit

Denied, re-write proposal

Evaluator: Signature:

Date:
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Proposal Defence Evaluation Result Form

To: Date:
Student Name

Project (1 Thesis [ Dissertation [

This is to inform you that your proposal entitled:

presented on (date) has been assessed with the following
result:

1. __ Approved, with minor or no correction

2. __ Approved, revise — no need to re-submit

3. ___ Revise, must re-submit proposal

4. __ Denied, re-write proposal

Please revise the proposal according to the comments and suggestions of the Proposal
Defence Panel under the guidance of your Primary Adviser and Secondary Adviser(s).
If required to re-submit/re-write, submission of the revised proposal should not take

more than three (3) months after the defence. Let me know if you have any questions.

Programme Leader:

Signature:

Date:
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Proposal Correction Confirmation Form
Final Oral Defence Correction Confirmation Form

Student Name:

Project LI Thesis [J Dissertation [

Title:

We, the undersigned, confirm that all the corrections suggested by the student’s panel
of oral examiners and the suggestions given during the defence have been incorporated

into the revised proposal/final oral project/thesis/dissertation.

Primary Adviser: Signature Date
Secondary Adviser: Signature Date
Secondary Adviser: (If applicable) Signature Date

FEREAEAIAAKRKAKAKRAAIAKAKAAIAAAAAKRAAAAAARAAIAAAAIAAIAAARAA XA RAhrhAdhdhdrrhhhkhiiiddhihiiix

Verified by: Date:
Programme Leader
Other General Remarks
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Oral Defence of Thesis/Dissertation Forms






Final Thesis Oral Defence Examination Form
Final Dissertation Oral Defence Examination Form

To: Date:

Programme Leader

This is to confirm that:

Student Name
Thesis O Dissertation [

Title:

has finalized his/her paper and is now ready for the Final Oral Defence and panel
examination.

Primary Adviser: Signature Date
Secondary Adviser: Signature Date
Secondary Adviser (If applicable): Signature Date
Programme Leader: Signature Date
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Proposal Correction Confirmation Form
Final Oral Defence Correction Confirmation Form

Student
Name:

Project LI Thesis [J Dissertation [

Title:

We, the undersigned, confirm that all the corrections suggested by the student’s panel
of oral examiners and the suggestions given during the defence have been incorporated

into the revised proposal/final oral project/thesis/dissertation.

Primary Adviser: Signature Date
Secondary Adviser: Signature Date
Secondary Adviser (If applicable): Signature Date

*hkkkhkhhkkhkkkhkhkhhkhkhkkhkhhhhkhkhkkhhhikhkhhhhhkhkhkkhihhrhkhkhhihkhkhhhhkikhkhhrhhkhkhhirihkhiiix

Verified by: Date:
Programme Leader
Other General Remarks
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Assessment, Evaluation and Grade Forms
[Used by advisers and assessors. For student information only.]

Reviewing these Forms informs you of how research is evaluated/graded.






External Examiner Evaluation Form
for the Final Oral Thesis Defence

Name of Student:

Thesis Title:

Direction: Please carefully read the attached manuscript and evaluate each
section using the rating scale below:

1. Below Average
2. Average
3. Above average

Items Rating Scales

Abstract

1. Abstract clearly conveys a focused overview of the research study. 1 2 3

Introduction

2. The background of the study gives adequate context to understand what the | 1 2 3
research is about.

3. The problem is relevant to the needs of society and significant enough to 1 2 3
add to existing knowledge.

4. If the study is quantitative, the research questions/hypotheses align with the | 1 2 3
purpose and variables.
If the study is qualitative, the research questions are aligned with selected
phenomenon.

5. The study is based on theories/concepts/principles.

6. The conceptual framework identifies the concepts/variables and the 1 2 3
presumed relationships among them.
7. Key concepts/variables and terminologies in the study are defined 1 2 3

according to how they are used in the study.
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Items Rating Scales

Review of Related Literature

8. There is adequate exploration of literature relevant to the research 1 2 3
problem and questions.

9. The literature review is organized systematically and logically based on 1 2 3
the key concepts/variables in the study.

10. The literature review is coherent in a way which offers new insights into 1 2 3
the topic.

Research Methodology

11. The research design for the study is appropriate. 1 2 3

12. The study population and sample procedures are clearly identified and 1123
described.

13. The sample size is representative of the target population. 1 2 3

14. The instruments for gathering data are clearly described. 1 2 3

15. The validation/reliability processes or trustworthiness of the instruments 1 2 3
are indicated.

16. The data analysis techniques for addressing the research questions are 1 2 3
appropriate.

17. The study complies with the ethical principles of social research. 1 2 3

Results & Discussion

18. The results are presented in relevant tables and/or figures based on the 1 2 3
research questions/objectives/hypotheses.

19. Interpretations of the results/findings are based on data analyses. 1 2 3

20. The results are discussed and compared with similar studies and those 1 2 3
found in the literature review.

Summary, Conclusions, & Recommendations

21. The summary re-articulates the research problem, methodology, and 1 2 3
findings of the study.

22. There is a clear link between the research questions and the conclusion 1 2 3
which logically flows from the findings.

23. The strength and focus of the recommendations are supported by findings 1 2 3
presented in the paper.

Other Considerations

24. The paper is free from typographical and grammatical errors. 1 2 3

25. Student’s overall grasp of the subject matter of his/her research. 1 2 3

26. Works cited in the thesis are in the list of References. 1 2 3

27. The references and citations are organized based on APA reference style. 1 2 3

28. The thesis is publishable. 1 2 3

Total Score:
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Overall Evaluation:
¢ Using the total score, indicate the evaluation of the thesis using the scale below.

Score Interpretation Evaluation (tick v one)
80-84 Excellent [ ]
73-79 Above average [ ]
66 - 72 Average [ ]
59 - 65 Below average [ ]
58 and below Poor [ ]

Should the student make corrections before the Final Oral Defence is scheduled?
()Yes ()No

Evaluator:

Signature: Date:
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External Examiner Evaluation Form for Computer Science

Adventist University of Africa
School of Postgraduate Studies
Evaluation Form for External Examiner
Name of Student:
Project (1 Thesis [

Title:

Direction: Please carefully read the attached manuscript and evaluate each section
using the rating scale below:
1 Below average

2 Average
3 Above average

Items Rating
Scale
Abstract
1. The abstract clearly conveys a focused overview of the research 1123
study.

Introduction

1. The background of the study gives adequate context to understand 11213
what the research is about.

2. The problem is relevant to the needs of society and significant 11213
enough to add to existing knowledge.

3. The research questions/hypotheses are measurable. 1123

e

The study is based on theories/concepts/principles.

5. Key concepts and terminologies in the study are defined according 11213
to how they are used in the study.
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Review of Related Literature

1. There is adequate exploration of literature relevant to the research 3
problem and questions.

2. The literature review is organized systematically and logically. 3

3. The literature review is coherent in a way which offers new insights 3
into the topic

Research Methodology

1. The research design for the study is appropriate. 3

2. The evaluation methods and the results are clearly defined. 3

3. The approach to arrive to the results is clearly described, as to enable 3
reproducibility of the research.

4. The study complies with ethical principles. 3

Results & Discussion

1. The results are presented in relevant tables and/or figures based on 3
the research questions/objectives/hypotheses.

2. Interpretations of the results/findings are validly based on the 3
approach defined in the methodology.

3. The results are discussed and compared with similar studies and 3
those found in the literature review.

Summary, Conclusions, & Recommendations

1. The summary re-articulates the research problem, methodology, and 3
findings of the study.

2. There is a clear link between the research questions and the 3
conclusion which logically flow from the findings.

3. The direction and focus of the recommendations are supported by 3
findings presented in the project/thesis.

4. The strength of the recommendations is supported by findings 3
presented in the project/thesis.

Other Considerations

1. The paper is free from typographical and grammatical errors. 3

2. The student’s overall grasp of the subject matter of his/her research 3
is sound.

3. The works cited in the project/thesis are in the list of References. 3

4. The references and citations are organized based on the IEEE Trans 3
reference style.

5. The project/thesis is publishable. 3
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Overall Evaluation:

e Add up all your rated scores of the Student from your evaluation above and
indicate the overall score using the following scale. Please circle the score

Score Interpretation
67 - 75 Very Satisfactory

63 - 66 Satisfactory

59 - 62 Major Changes

55- 58 Pass

Below 54 Failure

Should the student make the corrections before he/she finally defends?
()Yes ()No

External Examiner:

Signature:
Date:
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External Examiner Evaluation Form
Final Oral Dissertation Defence

Name of Student:

Dissertation Title:

Direction: Please carefully read the attached manuscript and evaluate each section
using the rating scale below:

1. Below Average

2. Average
3. Above average
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Items Rating
Scale
Abstract
1. Abstract clearly conveys a focused overview of the research study. 1123
Introduction
2. The background of the study gives adequate context to understand whatthe | 1 | 2 | 3
research is about.
3. The problem is relevant to the needs of society and significant enough to 1123
add to existing knowledge.
4. If the study is quantitative, the research questions/hypotheses align with the 1123
purpose and variables.
If the study is qualitative, the research questions are aligned with selected
phenomena.
5. The study is based on theories/concepts/principles.
6. The conceptual framework identifies the concepts/variables and the
presumed relationships among them.
7. Key concepts/variables and terminologies in the study are defined 1123
according to how they are used in the study.
8. The underlying assumptions of the study are clearly discussed. 1123
Items Rating
Scale
Review of Related Literature
9. There is adequate exploration of literature relevant to the research problem | 1 | 2 | 3
and questions.
10. The literature review is organized systematically and logically based onthe | 1 | 2 | 3
key concepts/variables in the study.
11. The literature review is coherent in a way which offers new insights intothe | 1 | 2 | 3
topic.
Research Methodology
23. The research design of the study is appropriate. 1123
24. The study population and sample procedures are clearly identified and 1123
described.
25. The sample size is representative of the target population. 1123
26. The instruments for gathering data are clearly described. 1123
27. The validation/reliability processes of the instruments are indicated. 1123
28. Statistical/Analytical tools are appropriate for research methods. 1123
29. The study conforms to ethical principles of social research. 1123
Results & Discussion
19. The results are presented in relevant tables and/or figures based on the 1123
research questions/objectives/hypotheses.
20. Interpretations of the results/findings are based on data analyses. 1123
21. The results are discussed and compared with similar studies and those 1123
found in the literature review.

186




22. Data analysis (presentation, interpretation, discussion) is consistent withthe | 1 | 2 | 3
research questions or hypotheses.

23. Data analysis (presentation, interpretation, discussion) is consistent with 1123
underlying theoretical/conceptual framework of the study.

24. Dissertation demonstrates mastery of the subject matter. 1123

Summary, Conclusions, & Recommendations
25. The summary re-articulates the research problem, methodology, and 1123
findings of the study.

26. There is a clear link between the research questions and the conclusion 1123
which logically flows from the findings.
27. Recommendations are insightful, appropriate and linked to the research 1123

findings/outcomes.
Research Contribution

28. Dissertation contributes knowledge and advances scholarship in the fieldof | 1 | 2 | 3
study.

29. The dissertation contributes a theory/model/framework that is likely tohave | 1 | 2 | 3
an impact on policy or practice.

30. The dissertation has reasonable potential for use by others either in 1123
application or in further research.
31. The dissertation is publishable in a peer reviewed journal. 1123
Items Rating
Scale
Other Considerations
32. Dissertation is free from typographical and grammatical errors. 1123
33. The references and citations are organized based on APA reference style. 1123
Total Score:

Overall Evaluation:
e Using the total score, indicate the evaluation of the dissertation using the scale

below.
Score Interpretation Evaluation (tick v' one)
95 -99 Excellent [ ]
88 - 94 Above average [ ]
80 - 87 Average [ ]
70-79 Below average [ ]
69 and below Poor [ ]

Should the student make corrections before the Final Oral Defence? ( ) Yes () No

Evaluator: Signature: Date:
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Final Oral Thesis Defence Assessment Form
Final Oral Dissertation Defence Assessment Form

Name of Student:

Programme:

Name of Assessor:

Title of Thesis/Dissertation:

Direction: The table below is a guide for assessing this oral defence. Rate each item
using the scale provided and return the form to the Chair of the Oral Defence Panel.

| 1— Poor | 2 — Fair | 3 - Good |  4—Excellent |
Category of Assessment Rating Scale
Introduction: Rationale of the Study 1 2 3 4
Adequacy of Background Information 1 2 3 4
Research Questions/Objectives 1 2 3 4
Methodology & Study Design 1 2 3 4
Analysis and Presentation of Results 1 2 3 4
Discussions/Implications 1 2 3 4
Conclusions & Recommendations 1 2 3 4
Clarity of Verbal (Oral)Presentation 1 2 3 4
Quality of Presentation 1 2 3 4
Content and Organization 1 2 3 4
Total Score:
Comments:
Assessment Interpretation Overall
Scale Assessment
(tick v one)
38 - 40 Excellent, passed with distinction. No corrections necessary. [ ]
34 -37 Good, passed. Minor corrections necessary. [ ]
29-33 Fair, passed. Major corrections necessary. [ ]
28 and Fail, work unacceptable as presented. [ ]
below Indicate reason(s) for failure & where revision should begin.
Comments:

Assessor’s Signature:

Date:

188



Adventist University of Africa

Grade Form for Advisers of SPS Students
(Return this Form to the Programme Leader)

Name of Student

Programme Research Date
Type
Role Name of Adviser Signature of Adviser*

*By signing and submitting this Grade Form, I certify that the work of this student
is completed and approved by me. The work conforms to the requirements of the
SPS Research Handbook in content, style and format. The AUA may affix my

signature to the Approval Page.

Please insert the letter grade only using the grading scale below. The appropriate
grade points will be derived and the final grade will be automatically calculated for

you.

Criterion

Letter
Grade

Grade Points

Sentence and paragraph structure

Format of headings, spacing, pagination

Organization of ideas

Clear introduction and relevant conclusions

Critical thinking and originality

Contribution to scholarship and profession

Grammar, spelling, punctuation

Use of gquotations and referencing

Appropriate research language

Final Letter Grade
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Grading Scale

Letter o ]
Grade Definition Honor Points
A Outstanding 0 4.00
A- Excellent 7 3.67
B+ Above Average 3 3.33
B Average 0 3.00
B- Below Average 7 2.67
C+ Weak 3 2.33
C Poor 0 2.00
C- Failing 7 1.67
D Failing 0 1.00
F Failing 0 0.00

Thank you for your advisement to this AUA student!
Your Adviser Honorarium will be paid within eight weeks of the student's graduation.
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Submission Form






Adventist University of Africa
Printing and Binding Form

Student
Surname: First Name:
Type: [ Dissertation [1Thesis [ Project Programme:
Research Title:
Primary Adviser: Secondary Adviser:

Declaration of Originality and Research Ethics

Read this statement carefully. Your signature below signifies that the following is true.
I hereby declare and signify that | know the AUA policies on plagiarism and have
taken all caution to uphold the ethics of research and writing. Further, | submit that if it
is found that I have violated the principles of research ethics, writing and academic
integrity, the University shall nullify my research and also apply other appropriate
sanctions.

Student Signature: Date:

One (1) copy of your dissertation/thesis/project will be printed and bound for display in the
collection of the Judith Thomas Library at AUA. Your account at AUA will be charged for
the printing and binding of the book. The Editor will send you a soft copy of your approved
paper and the printing instructions for the AUA binding format that you can use if you want
to have a personal copy of your paper printed and bound by the printer of your choice.

Disclaimer: By submitting this Form, you accept the AUA policy that all research may
be made available online through the Library. You should contact your Dean and request
to be exempted if you feel your research is sensitive and should not be made available.

******************BELOW FOR OFFICE USE ON LY********************
Programme Leader to complete Grade Information before Submission of Form

Primary Adviser Grade: Secondary Adviser Grade:
Defence Grade: Final Grade Grade submitted? [Yes [1No
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Project/Thesis/Dissertation Approval Signatures

Title

Purpose

Signature

Date

Programme Leader

Grade Record and Approval for
Submission to Research Director

Editor

Approval of Editing

Research Director

Approval for Submission to Dean

Dean

Final Approval of
Project/Thesis/Dissertation

Form Revision: September 2020
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The End

Better is the end of a thing than the beginning thereof: and the patient in spirit is
better than the proud in spirit. — Ecclesiastes 7:8, KJV

195



